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MOTO

“Dan apakah mereka tidak memperhatikan bumi, berapa banyaknya Kami

tumbuhkan di bumi itu pelbagai macam tumbuh-tumbuhan yang baik?”

(terjemahan Surat Asy Syuara ayat 7)1

1 Departemen Agama Republik Indonesia. Al-Quran Tajwid dan Terjemahan. 2006. Jakarta:

Maghfirah Pustaka.
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RINGKASAN

Pengaruh Perbedaan Vehicles dalam Gel Fraksi Air Ekstrak Umbi Bidara
Upas (Merremia Mammosa (Lour.)) terhadap Kepadatan Kolagen pada
Penyembuhan Luka Diabetik; Deuxy Ilma Wahyuliswari, 152010101053; 2019;
67 halaman; Fakultas Kedokteran Universitas Jember.

Diabetes Mellitus (DM) merupakan salah satu kelompok penyakit

metabolik yang ditandai dengan hiperglikemia karena gangguan sekresi insulin,

kerja insulin, atau keduanya. DM memiliki banyak komplikasi, salah satunya luka

diabetik. Peningkatan kadar gula darah dapat menghambat kerja leukosit sehingga

luka dengan mudah menjadi ulkus dan meluas. Manajemen luka diabetik cukup

sulit karena adanya pemanjangan fase penyembuhan luka. Pembuatan gel fraksi

air ekstrak etanol Umbi bidara upas (Merremia mammosa (Lour.)) diharapkan

mampu menjadi pilihan alternatif dalam pengobatan luka diabetik.

Tujuan penelitian ini untuk mengetahui pengaruh perbedaan vehicles

dalam gel fraksi air ekstrak etanol umbi bidara upas (Merremia mammosa (Lour.))

terhadap kepadatan kolagen pada penyembuhan luka diabetik. Penelitian ini

menggunakan desain penelitian true experimental design dengan rancangan post

test only randomized control group design. Terdapat 24 sampel penelitian yang

dihitung berdasarkan rumus Federer yang dibagi menjadi tiga kelompok kontrol

yaitu kontrol negatif (akuades), kontrol positif 1 (krim gentamisin 0,1%) serta

kontrol positif 2 (gel Bioplacenton) dan empat kelompok perlakuan yaitu

kelompok vehicle HPMC, kelompok vehicle Carbopol, dan kelompok vehicle Na

CMC. Variabel bebas dalam penelitian ini adalah jenis vehicles gel fraksi air

ekstrak umbi bidara upas, krim gentamisin dan gel Bioplacenton. Variabel terikat

dalam penelitian ini adalah tingkat kepadatan kolagen kulit tikus. Populasi pada

penelitian ini adalah tikus putih (Rattus novergicus) strain wistar jantan usia 2-3

bulan berat 150-220 gram. Pembuatan ekstrak dengan teknik ultrasonikasi

kemudian dilanjutkan fraksinasi dengan teknik partisi cair-cair untuk mendapat

fraksi air dan dilakukan pembuatan gel dengan vehicles berbeda yaitu HPMC,

Carbopol, dan Na CMC.
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Penelitian ini dilakukan 25 hari dimulai adaptasi tikus selama 7 hari,

induksi streptozotosin (STZ) 40 mg/kgBB, pemeriksaan glukosa, pemberian luka,

dan pemberian perlakuan yang diberikan secara topikal 2 hari sekali selama 10

hari sesuai kelompok yaitu kelompok kontrol negatif (akuades), kontrol positif 1

(krim gentamisin 0,1%), kontrol positif 2 (gel Bioplacenton®) dan 3 kelompok

yaitu gel  fraksi air ekstrak umbi bidara upas dengan vehicles HPMC, Carbopol,

dan Na CMC. Tikus dikorbankan pada hari ke-25 penelitian dan dilihat kepadatan

kolagen pada preparat pewarnaan Masson’s Trichrome dengan perbesaran 400x

dalam 6 lapang pandang kemudian diolah menggunakan perangkat lunak imageJ.

Uji statistik dilakukan menggunakan uji One Way Anova Post Hoc Fisher’s LSD.

Hasil pengamatan kepadatan kolagen didapatkan nilai rata-rata K-

(akuades) 24,60%, K+(1) (krim gentamisin 0,1%) 39,07%, K+(2) (gel

Bioplacenton) 49,10%, P1 (vehicle HPMC) 52,71%, P2 (vehicle Carbopol)

38,59%, dan P3 (vehicle Na CMC) 54,88%. Hasil uji One Way Anova didapatkan

nilai p<0,05 yang menunjukkan terdapat perbedaan signifikan antarkelompok,

sedangkan hasil post hoc Fisher’s LSD menunjukkan kelompok K- dengan K+(1),

K+(2), P1, P2, dan P3 memiliki nilai p<0,05 berarti terdapat perbedaan signifikan

antarkelompok. Kelompok K+(1) dengan K- dan P3 memiliki nilai p<0,05 berarti

terdapat perbedaan signifikan antarkelompok. Kelompok K+(2) dengan K-

memiliki nilai p<0,05 berarti terdapat perbedaan signifikan antarkelompok.

Kelompok P1 dengan K- dan P2 memiliki nilai p<0,05 berarti terdapat perbedaan

signifikan antarkelompok. Kelompok P2 dengan K-, P1, dan P3 memiliki nilai

p<0,05 berarti terdapat perbedaan signifikan antarkelompok. Kelompok P3

dengan K-, K+(1), dan P2 memiliki nilai p<0,05 berarti terdapat perbedaan

signifikan antarkelompok. Berdasarkan hasil penelitian tersebut dapat

disimpulkan terdapat pengaruh vehicles dalam gel fraksi air ekstrak etanol Umbi

bidara upas (Merremia mammosa (Lour.)) terhadap kepadatan kolagen pada

penyembuhan luka diabeti dimana vehicle Na CMC memiliki pengaruh paling

tinggi dibanding lainnya.
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1

BAB 1. PENDAHULUAN

1.1 Latar Belakang

Diabetes melitus (DM) ialah sebuah kondisi yang ditandai dengan

peningkatan konsentrasi glukosa dalam darah (hiperglikemia) dan dapat berujung

pada resiko kerusakan mikrovaskular (retinopati, nefropati, dan neuropati). DM

dapat terjadi karena gangguan metabolik menahun akibat pankreas tidak

memproduksi cukup insulin atau tubuh tidak dapat menggunakan insulin yang

diproduksi secara efektif. Insulin adalah hormon yang mengatur keseimbangan

gula darah, jika proses produksi maupun efektivitas tubuh dalam penggunaan

insulin menurun maka akan terjadi hiperglikemia. Data Riset Kesehatan Dasar

(Riskesdas) oleh Badan Penelitian dan Pengembangan Kesehatan (Litbangkes)

Kementrian Kesehatan Republik Indonesia pada tahun 2018 menyebutkan bahwa

prevalensi DM pada penduduk diatas usia 15 tahun sebesar 10%. Jumlah

penderita DM di Jawa Timur menduduki peringkat terbanyak ke-5 dari 34

provinsi (WHO, 2006; Kementerian Kesehatan Republik Indonesia, 2018).

Komplikasi DM terbanyak di Indonesia yaitu neuropati (13%-78%),

vaskulopati (16%-53%), dan luka diabetik (7.3%-24%). Luka diabetik adalah

gabungan kondisi yang rumit dari neuropati, vaskulopati, dan rentan infeksi yang

jika tidak disertai penanganan tepat dapat merujuk pada amputasi sehingga

morbiditas meningkat dan kualitas hidup pasien akan menurun. Neuropati dapat

menyebabkan luka diabetik karena menurunkan sensitivitas sentuhan dan tekanan

di daerah tertentu sehingga pasien DM akan mengalami penurunan kewaspadaan

terhadap benda yang dapat memicu terjadinya luka. Peningkatan kadar gula darah,

disisi lain, juga menghambat kerja leukosit sehingga luka dengan mudah menjadi

ulkus dan meluas. Estimasi insidensi seumur hidup pasien luka diabetik mencapai

hampir 25% (Yotsu dkk., 2014; Yusuf dkk., 2016; Prameswari, 2017).

Manajemen luka diabetik dibagi menjadi beberapa tahapan, yaitu 1.)

mengatasi penyakit komorbid; 2.) debridemen; 3.) menurunkan beban tekanan

pada derah luka; 4.) penanganan infeksi; 5.) menjaga kelembapan luka. Pilihan

obat seperti formulasi ekstrak plasenta dalam bentuk gel dapat mempercepat
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penyembuhan luka dengan meningkatkan faktor pertumbuhan endotel vaskular

dan sintesis kolagen. Sediaan gel memiliki efek bagus dalam menjaga kelembapan

luka (Shukla dkk., 2004; Marchianti dkk., 2018).

Indonesia memiliki 40.000 tumbuhan endemik (khas daerah) dan 7000

diantaranya tercatat sebagai tumbuhan obat. Namun, hanya ada kurang lebih 200

tumbuhan obat yang pernah diteliti. Taman Nasional Meru Betiri yang terletak di

Jember, Jawa Timur dihuni 26 tumbuhan obat yang telah teridentifikasi, salah

satunya bidara upas (Merremia mammosa (Lour.)) yang digunakan sebagai terapi

antidiabetik. Penelitian oleh Ratnadewi dkk., (2018) membandingkan kadar

flavonoid dan aktivitas antioksidan enam spesies tumbuhan obat antidiabetik

yaitu Antidesma bunius, Antidesma montanum, Arcangelista flava, Lagerstroemia

speciosa, Lunasia amasa Blanco, dan Merremia mammosa (Lour.). hasilnya,

bidara upas Merremia mammosa (Lour.) memiliki jumlah total flavonoid dan

aktivitas antioksidan yang tinggi dibandingkan spesies lainnya. Bidara upas

(Merremia mammosa (Lour.)) mengandung flavonoid (antiinflamasi dan

antioksidan) dan senyawa resin glikosida seperti merremosida A, E, J, mammosa

yang spesifik terkandung dalam akar dan umbinya, yang memiliki aktivitas

sebagai antibakteri dengan cara membuat lubang pada membran. Kandungan

tersebut juga dapat memicu makrofag untuk menghasilkan growth factor,

menetralisir radikal bebas, mempercepat fase inflamasi, memicu proliferasi sel,

dan meningkatkan sintesis kolagen yang berperan dalam penutupan luka (Hidayat

dkk., 2015; Prameswari, 2017; Ratnadewi dkk., 2018).

Pemanfaatan umbi bidara upas sebagai alternatif obat penyembuhan luka

diabetik pernah diteliti oleh Julianto (2015) dan Sofiana dkk. (2015) dengan hasil

didapatkan pengaruh positif ekstrak umbi bidara upas (Merremia mammosa

(Lour.)) 200 mg terhadap presentase penyembuhan luka diabetik. Namun pada

kedua penelitian tersebut kandungan ekstrak umbi bidara upas masih bercampur

dengan komponen tidak aktif sehingga perlu isolasi senyawa menggunakan

metode fraksinasi. Penelitian Prameswari (2017) yang menggunakan metode

fraksinasi dari ekstrak etanol umbi bidara upas (Merremia mammosa (Lour.))

dengan tiga jenis pelarut yang berbeda berdasarkan polaritas yaitu air, etil asetat,
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dan n-heksana dengan melihat pengaruh secara mikroskopis yaitu kepadatan

kolagen yang terbentuk memberikan hasil bahwa fraksi air memiliki pengaruh

paling besar terhadap penyembuhan luka diabetik.

Peneliti ingin melanjutkan penelitian tersebut dengan menggunakan

metode pembuatan sediaan gel fraksi air ekstrak etanol umbi bidara upas

(Merremia mammosa (Lour.)) dengan tiga jenis pembawa/vehicle yang berbeda

yaitu HPMC, NACMC, dan Carbopol dan melihat pengaruh mikroskopis

berdasarkan kepadatan kolagen yang terbentuk. Pembuatan sediaan gel diperlukan

karena dapat menjaga kelembapan jaringan sehingga dapat mempercepat

terjadinya reepitalisasi jaringan melalui stimulasi proliferasi dan migrasi sel epitel

serta peningkatan aktivitas growth factor. Bahan pembawa/vehicle sangat penting

dalam sediaan gel karena akan memberi pengaruh yang signifikan terhadap

absorbsi obat, sehingga pemilihannya harus tepat yakni mudah diaplikasikan pada

kulit, tidak mengiritasi serta dapat melepaskan bahan aktif ke sisi aksi dengan

cepat. Pemeriksaan kepadatan kolagen dipilih karena peranan kolagen sangat

penting pada proses penyembuhan luka yaitu dalam proses hemostasis, interaksi

dengan trombosit dan fibronektin, peningkatan komponen seluler, peningkatan

faktor pertumbuhan dan peningkatan proses fibroplasias serta proliferasi

epidermis. Pembentukan serabut kolagen oleh sel fibroblas akan menutup luka

seiring dengan peningkatan kepadatannya. Kepadatan kolagen akan dilihat

menggunakan pewarnaan Masson’s trichrome yang merupakan pewarnaan

spesifik serabut kolagen dan diteliti dengan pengamatan preparat histopatologi

kulit menggunakan mikroskop (Amin dan Doupis, 2016; Prameswari, 2017)

Berdasarkan uraian tersebut peneliti ingin mengetahui pengaruh bahan

pembawa/vehicles dalam gel fraksi air ekstrak umbi bidara upas (Merremia

mammosa Lour) terhadap kepadatan kolagen pada penyembuhan luka diabetik.

1.2 Rumusan Masalah

Berdasarkan latar belakang yang telah diuraikan maka rumusan masalah

yang diajukan adalah bagaimana pengaruh perbedaan bahan pembawa/vehicles

HPMC, Carbopol, dan Na CMC dalam gel fraksi air ekstrak umbi bidara upas
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(Merremia mammosa (Lour.)) terhadap kepadatan kolagen pada penyembuhan

luka diabetik?

1.3 Tujuan Penelitian

Tujuan penelitian ini adalah mengetahui pengaruh perbedaan bahan

pembawa/vehicles HPMC, Carbopol, dan Na CMC dalam gel fraksi air ekstrak

umbi bidara upas (Merremia mammosa (Lour.)) terhadap kepadatan kolagen pada

penyembuhan luka diabetik.

1.4 Manfaat Penelitian

Manfaat teoritis penelitian ini sebagai berikut.

a. Sebagai informasi ilmiah mengenai penggunaan bahan pembawa/vehicles

dalam gel fraksi air ekstrak umbi bidara upas (Merremia mammosa

(Lour.)) secara topikal dalam penyembuhan luka diabetik.

b. Dapat dijadikan sebagai salah satu dasar pengembangan penelitian umbi

bidara upas (Merremia mammosa (Lour.)) sebagai terapi penyembuhan

luka diabetik.
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BAB 2. TINJAUAN PUSTAKA

2.1 Umbi Bidara Upas (Merremia mammosa (Lour.))

2.1.1 Taksonomi

Menurut Plantamor (2018), taksonomi umbi bidara upas sebagai berikut.

Kingdom : Plantae

Subkingdom : Spermatophyta

Divisi : Magnoliophyta

Kelas : Magnoliopsida

Subkelas : Asteridae

Ordo : Solanales

Famili : Convolvulaceae

Genus : Merremia

Spesies : Merremia mammosa (Lour.)

Gambar umbi bidara upas dapat dilihat pada Gambar 2.1 di bawah ini.

Gambar 2.1 Umbi Bidara Upas (Merremia mammosa (Lour.))
(Sumber: CCRC, 2014)

2.1.2 Kegunaan Umbi Bidara Upas

Bidara upas merupakan tanaman yang dapat ditemui di Taman Nasional

Meru Betiri dan termasuk tanaman obat asal Indonesia. Umbi bidara upas

memiliki beberapa kegunaan yaitu sebagai anti radang, analgesik, antitoksik
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gigitan ular, pengobatan kusta, difteri, typhoid, dan diabetes melitus (DM).

Kandungan umbi bidara upas berupa flavonoid dan senyawa glikosida resin

seperti merremosida A, E, J mammosa memiliki aktivitas sebagai antibakteri

(Hidayat dkk., 2015).

a. Flavonoid

Flavonoid memiliki sifat lipofilik dan dapat menghancurkan membran

bakteri. Flavonoid juga menghambat replikasi dan translasi bakteri melalui

hambatan fungsi DNA gyrase. Selain itu, flavonoid dapat meningkatkan aktivitas

IL-2 dan proliferasi limfosit yang dapat mengaktivasi sel CD+ untuk

mempengaruhi SMAF (molekul IFNɣ) sehingga makrofag teraktivasi dan terjadi

proses fagositosis. Dengan aktivitas tersebut flavonoid dapat merangsang sel

seperti makrofag untuk melakukan aktivasi growth factor seperti EGF, TGF-β, IL-

1, IL-4, IL-8 sehingga mempercepat memasuki fase proliferasi dan penyembuhan

luka. Selain itu, efek antioksidan mempercepat fase inflamasi dengan menangkap

radikal bebas dan mencegah reaksi oksidasi dengan meningkatkan aktivitas enzim

Superoxide dismutase (SOD) dan glutation transferase. Flavonoid juga memiliki

efek antidiabetik dengan menghambat enzim glukosidase dan alfa amilase yang

berfungsi memecah karbohidrat menjadi monosakarida. Penghambatan tersebut

menyebabkan kadar glukosa menurun dalam darah disebabkan oleh gagalnya

pemecahan karbohidrat menjadi monosakarida (Hidayat dkk., 2015; Julianto,

2015).

b. Glikosida resin

Glikosida resin atau sering juga disebut glikoresin merupakan senyawa

metabolit sekunder yang hanya dimiliki golongan tumbuhan famili

Convolvulaceae. Glikosida resin tidak terkandung dalam semua organ, melainkan

hanya pada biji dan akar tumbuhan famili Convolvulaceae saja. Glikosida resin

memiliki beberapa aktivitas biologi seperti antibakteri, antituberkulosa, antitumor,

antidepresan, dan anti konvulsan (Tasdemir dkk., 2008).
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2.2 Diabetes Melitus (DM)

2.2.1 Definisi Diabetes Melitus (DM)

Diabetes Melitus merupakan penyakin endokrin yang ditandai dengan

peningkatan glukosa darah atau hiperglikemia yang berujung pada kerusakan

mikrovaskular (retinopati, nefropati, dan neuropati) (WHO, 2006). Sedangkan

menurut Infodatin Kementerian Kesehatan Republik Indonesia (2014), Diabetes

Melitus adalah penyakit gangguan metabolik kronis akibat kekurangan insulin

atau resistensi insulin sehingga terjadi peningkatan konsentrasi glukosa darah atau

hiperglikemia.

2.2.2 Klasifikasi Diabetes Melitus (DM)

DM umumnya dibagi menjadi 2, DM tipe 1 dan DM tipe 2. DM tipe 1

merupakan penyakit autoimun yang disebabkan destruksi sel beta pankreas

penghasil insulin. Karenanya, pasien DM tipe 1 hanya memproduksi sedikit

insulin dan membutuhkan substitusi insulin untuk mengendalikan konsentrasi gula

darah. DM tipe 2 disebabkan oleh resistansi insulin dan kompensasi yang buruk

oleh sel beta pankreas sehingga menyebabkan defisiensi insulin. DM tipe 2

berhubungan dengan pola hidup dan jumlah kasusnya cukup tinggi pada kasus

obesitas (Setiati dkk., 2014).

2.2.3 Diagnosis Diabetes Melitus (DM)

Menurut Perkumpulan Endokrinologi Indonesia (2011) diagnosis DM

ditegakkan atas dasar pemeriksaan kadar glukosa darah. Pemeriksaan yang

dianjurkan antara lain pemeriksaan glukosa secara enzimatik dengan bahan darah

plasma vena. Penggunaan bahan darah utuh (whole blood), vena, ataupun kapiler

tetap dapat digunakan dengan memperhatikan angka-angka kriteria diagnostik

sesuai pembakuan oleh WHO. Diagnosis dapat ditegakkan melalui tiga cara

sebagai berikut.

a. gejala klasik DM + glukosa plasma sewaktu >200 mg/dl (11,1 mmol/L)

b. gejala klasik DM + glukosa plasma puasa >126 mg/dl (7,0 mmol/L)

c. glukosa plasma 2 jam pada TTGO >200 mg/dl (11,1 mmol/L)
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Gejala klasik tersebut antara lain poliuria, polidipsia, polifagia, dan berat

badan menurun tanpa alasan jelas. Sementara gejala tidak khasnya antara lain

kesemutan, lemas, luka sulit sembuh, gatal, mata kabur, disfungsi ereksi (pria) dan

pruritus vagina (wanita).

Glukosa plasma sewaktu adalah hasil pemeriksaan glukosa darah tanpa

memperhatikan waktu makan terakhir, glukosa plasma puasa adalah hasil

pemeriksaan glukosa darah setelah dipuasakan minimal 8 jam, sedangkan TTGO

adalah toleransi glukosa oral dimana pemeriksaan dilakukan setelah dipuasakan 8

jam, diberi glukosa oral, dipuasakan kembali 2 jam lalu diperiksa kadar glukosa

darahnya (Setiati dkk., 2014).

.

2.3 Model Tikus Diabetes Melitus I

Diabetes Melitus  (DM) tipe 1 merupakan penyakit endokrin yang

kompleks dimana banyak sistem organ yang terlibat. Oleh karena itu, dibuat

model tikus DM tipe 1 untuk memudahkan  pengamatan aspek penyakit yang

akan diteliti (King, 2012). Penggunaan tikus sebagai model DM tipe 1 karena

keunggulan tikus dibandingkan spesies lain seperti ukuran tikus yang mudah

dilakukan induksi dan rentang periode induksi yang pendek pada tikus. Model

tikus DM dapat dikatakan mengalami hiperglikemia jika level gula darah pada

keadaan tidak puasa sebesar >200 mg/dl dan >150 mg/dl pada keadaan puasa

(Furman, 2015).

DM tipe 1 memiliki karaktistik utama dimana terjadi destruksi autoimun

dari sel beta pankreas, yang memungkinkan terjadinya penurunan produksi

insulin. Sebagai akibatnya, terjadi hiperglikemia, polidipsia dan poliuria.  Pada

model tikus DM tipe 1, penurunan produksi insulin didapatkan melalui beberapa

mekanisme seperti ablasi sel beta pankreas secara kimia sampai dengan

melakukan rekayasa genetika untuk menghasilkan tikus yang terlahir dengan DM

autoimun. Induksi model tikus DM tipe 1 secara kimia dapat dilakukan dengan

dua senyawa yaitu streptozotocin (STZ) dan aloksan. Induksi dilakukan 5-7 hari
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sebelum penelitian dilakukan untuk memastikan tikus mengalami hiperglikemia

stabil (King, 2012).

2.3.1 Induksi STZ

STZ disintesis dari Streptomycetes achromogenes. Administrasi STZ dapat

dilakukan secara intravena maupun intraperitoneal. STZ yang telah diadministrasi

akan masuk sel beta pankreas melalui glucose transporter (GLUT-2) dan

menyebabkan alkilasi DNA. Aktivasi berkelanjutan dari poly (ADP-ribose)

polymerase (PARP) menyebabkan deplesi nicotinamide adenine dinucleotide

(NAD+), penurunan adenosine triphosphate (ATP) selular, dan inhibisi produksi

insulin secara kontinyu. Selain itu, STZ juga merupakan sumber radikal bebas

yang dapat merusak DNA dan berakibat kematian sel. STZ dapat diadministrasi

secara dosis tinggi tunggal (single high dose)  maupun dosis rendah berulang

(multiple low dose) (King, 2012).

Administasi STZ secara dosis tinggi tunggal merupakan prosedur yang

paling sering dilakukan, dimana dosis STZ yang dibutuhkan yaitu 40-70

mg/kgBB dan diinjeksikan kepada tikus berumur 8 sampai 10 minggu dalam satu

waktu (Furman, 2015). Sedangkan pada administrasi STZ secara dosis rendah

berulang, dosis yang digunakan yaitu 20-40 mg/kgBB dan diinjeksikan sekali

sehari dalam 5 hari (King, 2012).

STZ tergolong sebagai larutan yang tidak seimbang, sehingga harus

dilakukan penyimpanan pada suhu 20 derajat Celcius untuk menghindari

penguapan. Pencampuran dengan buffer sitrat harus dilakukan tepat sebelum

injeksi untuk menghindari dekomposisi STZ dalam buffer sitrat. Pemilihan jenis

kelamin tikus juga berpengaruh dalam induksi STZ, karena sel beta pankreas tikus

jantan lebih sensitif terhadap sitotoksisitas STZ dibandingkan tikus betina. Hal

tersebut dikarenakan hormon estrogen pada tikus betina dapat menurunkan

sensitivitas terhadap STZ. Hipoglikemia sering terjadi 48 jam setelah injeksi STZ,

sehingga perlu dilakukan pemberian sukrosa 10% untuk menghindari sudden

death hypoglycemic (Furman, 2015).
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2.3.1 Induksi Aloksan

Aloksan dapat menyebabkan efek diabetes pada tikus dengan

pembentukan radikal bebas, dimana sel beta pankreas memiliki mekanisme

pertahanan lemah dalam menangkal radikal bebas tersebut dan akan

terfragmentasi. Dosis yang digunakan pada induksi aloksan terhadap tikus yaitu

40-200 mg/kgBB secara intravena namun juga dapat dilakukan secara

intraperitoneal maupun subkutan dengan dosis tiga kali dosis intravena. Namun

perlu diperhatikan bahwa aloksan memiliki rentang dosis diabetogenik yang

sempit, sehingga sedikit saja terjadi kelebihan dosis dapat menyebabkan toksisitas

yang meluas, terutama pada ginjal (King, 2012).

2.4 Luka Diabetik

2.4.1 Definisi Luka Diabetik

Luka diabetik adalah salah satu komplikasi diabetes melitus (DM) yang

disebabkan beragam penyebab namun yang paling banyak ialah neuropati dan

vaskulopati (Amin dan Doupis, 2016). Mekanisme penyembuhan luka yang lama

pada luka diabetik menyebabkan resiko amputasi yang tinggi, dan berpengaruh

terhadap kualitas hidup pasien serta meningkatnya morbiditas (Yotsu dkk., 2014).

2.4.2 Patofisiologi Luka Diabetik

Luka diabetik disebabkan oleh neuropati dan vaskulopati serta kegagalan

resistensi terhadap infeksi mikroba. Luka diabetik dapat dipicu oleh trauma.

Namun, adanya neuropati menyebabkan hilangnya sensasi pada saraf dan

menyebabkan trauma tidak terasa sehingga hilangnya rasa awas diri yang

berakibat lebih mudah terkena trauma lagi. 66% neuropati pada DM terjadi di

ekstremitas bawah. Neuropati dapat disebabkan oleh hiperglikemia, abnormalitas

metabolisme asam lemak, dan aktivasi jalur C-kinase. Protein C-kinase (PKC)

merupakan enzim yang memiliki peran penting dalam fungsi selular dan

transduksi sinyal. PKC dapat teraktivasi karena hiperglikemia yang menyebabkan

reduksi aktivitas Na+-K+-ATPase sehingga menurunkan konduksi dan regenerasi
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saraf. Adanya vaskulopati menyebabkan iskemia jaringan, sehingga penyembuhan

luka melambat dan prognosis memburuk (Noor dkk., 2015).

2.4.3 Klasifikasi Luka Diabetik

Klasifikasi luka diabetik didasarkan pada karakteristik lukanya seperti

kedalaman, ukuran, lokasi dan penampakan. Pengklasifikasian luka diabetik

digunakan untuk memetakan progres dalam tatalaksana (Noor dkk., 2015).

a. Klasifikasi Wagner-Meggit

Klasifikasi Wagner-Meggit dapat dilihat pada Tabel 2.1 berikut.

Tabel 2.1 Klasifikasi Wagner-Meggit
Derajat Luka diabetik
0 Luka tertutup atau selulitis
1 Luka superfisial
2 Luka dalam sampai tendon dan jaringan persendian
3 Luka dalam dengan abses, osteomyelitis, dan radang persendian
4 Gangren lokal
5 Gangren luas
Sumber: Noor dkk., 2015

b. Klasifikasi University of Texas

Klasifikasi ini merupakan modifikasi dari klasifikasi Wagner. Klasifikasi

University of Texas dapat dilihat dalam tabel berikut.

Tabel 2.2 Klasifikasi University of Texas
Stage Grades

0 1 2 3
A Pre atau post luka

diabetik yang
telah sembuh

Luka superfisial
tanpa

melibatkan
tulang

Luka terbuka
hingga tendon

atau kapsul
sendi

Luka terbuka
hingga tulang

atau sendi

B Luka dengan
infeksi

Luka dengan
infeksi

Luka dengan
infeksi

Luka dengan
infeksi

C Luka dengan
iskemia

Luka dengan
iskemia

Luka dengan
iskemia

Luka dengan
iskemia

D Luka dengan
infeksi dan

iskemia

Luka dengan
infeksi dan

iskemia

Luka dengan
infeksi dan

iskemia

Luka dengan
infeksi dan

iskemia
Sumber: Noor dkk., 2015
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c. Klasifikasi PEDIS

Klasifikasi ini diajukan oleh International Working Group on the

Diabetic Foot. Klasifikasi PEDIS dapat dilihat dalam Tabel 2.3 berikut.

Tabel 2.3 Klasifikasi PEDIS
Penurunan Perfusi 1= tidak ada

1= vaskulopati ringan
2= iskemik

Ukuran/Kedalaman 1= full-thickness superfisial, mencapai dermis
2= ulser dalam, melebihi dermis, struktur subkutan, fasia, otot dan
tendon
3= seluruh lapisan hingga otot dan atau sendi

Infeksi 1= tidak ada infeksi
2= infeksi pada kulit dan jaringan subkutan
3= eritema >2cm atau infeksi yang melibatkan struktur subkutan
tanpa respon imun sistemik
4= infeksi dengan manifestasi sistemik: demam, leukositosis,
hipotensi

Penurunan Sensasi 1= tidak ada
2= ada

Sumber: Waspadji, 2015

2.4.4 Penatalaksanaan Luka Diabetik

Tatalaksana luka diabetik dapat dilakukan dengan debridemen dan

pemberian antibiotik. Debridemen merupakan langkah pertama pada tatalaksana

luka diabetik karena menghilangkan jaringan nekrotik. Namun harus berhati-hati

pada keadaan iskemia, sehingga lebih baik dilakukan revaskularisasi sebelum

dilakukan debridemen. Beberapa jenis debridemen dapat dilakukan bergantung

pada derajat luka diabetik, contohnya debridemen surgical, debridemen

enzimatik, dan debridemen mekanik (Amin dan Doupis, 2016).

Infeksi kerap terjadi pada luka diabetik sehingga perlu ditangani agar

bakteri tidak menghambat proses penyembuhan luka. Antibiotik dapat diberikan

secara tunggal ataupun dikombinasikan dengan dressing, kecuali pada luka

diabetik nekrotik. Antibiotik yang efektif antara lain gentamisin, neomisin dan

mupirosin. Dressing digunakan untuk meminimalisir iritasi dan rasa tidak nyaman

serta meningkatkan kelembapan kulit (Amin dan Doupis, 2016).
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2.5 Proses Penyembuhan Luka

2.5.1 Proses Fisiologis Penyembuhan Luka

Luka adalah keadaan dimana struktur anatomi dan fungsi jaringan

mengalami kerusakan atau disrupsi (Velnar dkk., 2009). Proses penyembuhan

luka merupakan proses yang kompleks dan terdiri dari beberapa fase yaitu

koagulasi dan hemostasis, inflamasi, proliferasi, dan remodeling (Barrientos dkk.,

2008). Keempat fase tersebut dapat dilihat pada Gambar 2.2 di bawah ini.

Gambar 2.2 Fase Penyembuhan Luka (Wound Care Community, 2015)

a. Fase Koagulasi dan Hemostasis

Bersamaan dengan terjadinya proses hemostatis, kaskade koagulasi

teraktivasi melalui jalur ekstrinsik maupun intrinsik yang menyebabkan agregasi

platelet dan formasi blood clot. Terjadinya kontak antara darah pada daerah luka

dan platelet dengan kolagen dan matriks ekstraselular menyebabkan pelepasan

faktor pembekuan darah dan formasi blood clot dari platelet yang terdiri dari

fibronektin, fibrin, vitronektin, dan trombospondin. Koagulasi dan hemostatis

terjadi tepat setelah adanya trauma. Mekanisme yang terjadi mempunyai tujuan

jangka pendek yaitu mencegah perdarahan masif dan tujuan jangka panjang yaitu

mempersiapkan matriks untuk fase penyembuhan selanjutnya (Velnar dkk., 2009).
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b. Fase Inflamasi

Fase inflamasi dibagi menjadi dua tahap, early inflammation dan late

inflammation. Early inflammation dimulai pada akhir fase koagulasi dan beberapa

saat setelah fase tersebut berakhir. Early inflammation mengaktivasi kaskade

komplemen yang mencetuskan infiltrasi neutropil pada daerah luka. Fungsi

neutrofil untuk mencegah infeksi dengan melakukan fagositosis bakteri, partikel

asing dan jaringan rusak melalui pelepasan enzim proteolitik. Neutrofil akan

berangsur-angsur berubah dalam beberapa hari setelah faktor kontaminan

tereradikasi. Neutrofil kemudian akan dieliminasi dengan ekstruksi ke permukaan

luka sebagai slough dan terapoptosis. Late inflammation terjadi 48-72 jam setelah

trauma terjadi, ditandai dengan munculnya makrofag pada daerah luka yang

melakukan fagositosis. Yang mencetuskan pelepasan makrofag antara lain faktor

pembekuan darah, komponen komplemen, sitokin seperti platelet-derived growth

factor (PDGF), transforming growth factor β (TGF-β), leukotriene B4, dan faktor

IV. Makrofag memiliki usia yang lebih panjang dibandingkan neutrofil dan

bekerja dalam pH yang rendah. Peran penting makrofag dalam fase ini ialah

berperan sebagai sel regulator yang memicu faktor pertumbuhan jaringan dan

mediator lain seperti fibroblast growth factor (FGF) dan kolagen. Limfosit

muncul 72 jam setelah terjadi trauma yang ditandai dengan aksi IL-1 yang

berperan dalam regulasi kolagenase yang dibutuhkan untuk fase berikutnya

(Velnar dkk., 2009)

c. Fase Proliferasi

Fase proliferasi dimulai pada hari ketiga setelah trauma dan bertahan

sekitar 2 minggu. Secara mikroskopis, fase ini ditandai dengan migrasi fibroblas,

desposisi matriks ekstraselular baru dan adanya pembentukan jaringan granul.

Fibroblas sudah diproduksi oleh jaringan sekitar luka pada 3 hari pertama

pascatrauma, kemudian bermigrasi ke daerah luka karena dipicu oleh TGF-β dan

PDGF yang dihasilkan sel-sel inflamatori dan platelet. Setelah berada di daerah

luka, fibroblas akan memproduksi matriks protein hialuronan, fibronektin,

proteoglikan dan prokolagen tipe 1 dan 3. Kolagen merupakan komponen penting

dalam proses penyembuhan luka karena memperbaiki integritas dan kekuatan
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jaringan yang rusak. Proses yang terjadi selanjutnya ialah pembentukan pembuluh

darah baru atau angiogenesis (Velnar dkk., 2009).

d. Fase Remodelling

Fase terakhir dari penyembuhan luka ialah fase remodeling. Fase ini

berperan dalam pertumbuhan jaringan epitel baru dan pembentukan jaringan

parut. Bersamaan dengan pematangan matriks intraseluluer, berkas kolagen juga

bertambah diameternya serta asam hialuronik dan fibronektin terdegradasi. Proses

ini dapat terjadi sampai setahun atau lebih, tergantung pada keparahan luka.

Setelah luka sembuh, fibroblas dan makrofag akan jauh berkurang dan

angiogenesis juga berhenti (Velnar dkk., 2009).

2.5.2 Proses Penyembuhan Luka pada Diabetes Melitus (DM)

Penderita DM mengalami penyembuhan luka yang lebih lama

dibandingkan dengan keadaan normal, baik itu luka akut maupun luka kronis yang

berujung pada diabetic foot ulcer (DFU). Beberapa mekanisme patofisiologi yang

mendasari hal tersebut antara lain hipoksia jaringan, disfungsi sel epidermal dan

fibroblas, angiogenesis yang tidak sempurna, peningkatan ROS atau radikal

bebas, penurunan resistensi imun, dan neuropati (Guo dan Dipietro, 2010).

2.6 Kepadatan Kolagen

2.6.1 Definisi Kepadatan Kolagen

Kolagen adalah komponen terbesar yang membangun jaringan ikat dan

merupakan sekitar 25% dari total protein seluruh tubuh (Murray dkk., 2009).

Kolagen terdapat pada tendon, ligamen, matriks tulang dan dentin, kulit, arteri,

dan kartilago. Dalam penyembuhan luka terdapat proses yang dinamis dan

kompleks, salah satunya ialah pendepositan kolagen (Fratzl, 2008; Murray dkk.,

2009; Velnar dkk., 2009).

2.6.2 Sintesis Kolagen

Kolagen disintesis di ribosom oleh fibroblas dalam bentuk prekursor yaitu

preprokolagen. Preprokolagen memiliki rangkaian sinyal yang mengarahkan
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rantai polipetida tersebut ke dalam lumen retikulum endoplasma, kemudian di

dalam lumen retikulum endoplasma terjadi eliminasi rangkaian sinyal secara

enzimatik. Sintesis kolagen dimulai dengan polipetida subunit atau rantai alfa

yang dipilin menjadi struktur triple helical. Glisin, asam amino berukuran kecil,

dimasukkan ke dalam inti dari struktur triple helix dan membentuk formasi Gly-

X-Y. X dan Y dapat disusun dari berbagai jenis asam amino, namun 100 posisi

dari formasi X disusun oleh prolin dan 100 posisi dari formasi Y disusun oleh

hidroksiprolin. Hidroksiprolin dibentuk dari hidroksilasi prolin yang dikatalisasi

oleh enzim prolyl hydroxylase dengan bantuan kofaktor vitamin C dan α-

ketoglutarat. Lisin pada formasi Y juga dapat dimodifikasi menjadi hidroksilisin

melalui lysyl hydroxylase. Serabut kolagen yang telah terbentuk akan distabilisasi

dengan pembentukan covalent cross-link antarunit triple helix (Murray dkk.,

2009).

2.6.3 Peran Kolagen dalam Penyembuhan Luka

Kolagen memegang peranan penting dalam penyembuhan luka yaitu

mengembalikan integritas dan kekuatan jaringan. Kolagen menjadi dasar bagi

pembentukan matriks intraselular dalam luka. Pada jaringan dermis sehat,

komposisi kolagen tipe 1 sebanyak 80% dan tipe 3 sebanyak 25%. Sedangkan

dalam kondisi terluka, granulasi jaringan menyebabkan peningkatan komposisi

kolagen tipe 3 menjadi 40%. Kolagen tipe 3 terbentuk pada hari pertama hingga

hari ketiga pasca trauma kemudian digantikan kolagen tipe 1 yang lebih kuat

(Velnar dkk., 2009)

2.6.4 Pengukuran Kepadatan Kolagen

Kepadatan kolagen dapat dilihat melalui pengamatan preparat histoPA

jaringan kulit yang diberi perwarnaan Masson’s trichrome (MT). Jaringan yang

diberi pewarnaan MT memperlihatkan desposisi serabut kolagen yang terpulas

warna biru. Hal tersebut terjadi karena pada pewarnaan MT bagian yang bersifat

asidofilik seperti sitoplasma, otot, dan kolagen mengikat pewarna yang bersifat

asam. Kemudian diberikan asam phosophomolybidic untuk menghilangkan warna
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pada kolagen namun tidak pada sitoplasma. Kolagen yang telah dihilangkan

warnanya kemudian diwarnai menggunakan methyl blue, aniline blue, atau fast

green dye (Suvik, 2012). Pengukuran kepadatan kolagen dapat dilakukan secara

kuantitatif dan semikuantitatif.

Pengukuran kuantitatif dilakukan dengan pengamatan menggunakan

mikroskop perbesaran 400x dan diambil gambar menggunakan kamera optilab.

Kepadatan kolagen kemudian diukur menggunakan perangkat lunak analisis

gambar seperti imageJ dengan menghitung luas kolagen berdasarkan kontras

warna (Chen dkk., 2012; Pricilla dkk., 2017).

Pengukuran semikuantitatif berdasarkan scoring histoPA untuk kepadatan

kolagen menurut Rizka dkk. (2013) sebagai berikut.

1. 0 = tidak ditemukan serabut kolagen pada daerah luka

2. +1 = kepadatan kolagen rendah jika serabut kolagen kurang dari 10%

per lapang pandang

3. +2 = kepadatan kolagen sedang jika serabut kolagen 10-50% per

lapang pandang

4. +3 = kepadatan kolagen rapat jika serabut kolagen 50-90% per lapang

pandang

5. +4 = kepadatan kolagen sangat rapat jika serabut kolagen 90-100%

per lapang pandang

Gambar 2.3 Kepadatan kolagen pada luka dengan pewarnaan Masson’s trichome
(Suvik, 2012)
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2.7 Tinjauan Umum Metode Pembuatan Ekstrak

Ekstraksi adalah proses mengeluarkan zat aktif dari simplisia nabati

maupun simplisia hewani menggunakan pelarut yang sesuai, kemudian pelarut

diuapkan sehingga menyisakan massa atau serbuk berupa sediaan pekat yang

disebut ekstrak. Proses ekstraksi dilakukan berdasarkan teori penyarian yaitu

peristiwa pemindahan massa. Pemindahan massa yang dimaksud ialah

pengeluaran zat aktif dari dalam sel menggunakan cairan penyari sehingga larutan

zat aktif terperangkap dalam cairan penyari (Ningsih dkk., 2016). Beberapa target

ekstraksi antara lain (Mukhriani, 2014):

1. Senyawa bioaktif yang tidak diketahui

2. Senyawa yang diketahui ada pada suatu organisme

3. Sekelompok senyawa dalam suatu organisme yang berhubungan secara

struktural.

Senyawa bioaktif pada tumbuhan diproduksi sebagai metabolit sekunder.

Produksi dari metabolit sekunder pada spesies yang berbeda disebabkan spesies

tersebut membutuhkannya. Contohnya, sintesis aroma pada beberapa spesies

tumbuhan untuk memikat serangga melakukan penyerbukan, sintesis senyawa

toksik untuk menghentikan tumbuhan lain yang mengganggu. Sehingga arti dari

senyawa bioaktif pada tumbuhan adalah metabolit sekunder yang menimbulkan

efek farmakologi ataupun efek toksik pada manusia dan hewan.

Ekstraksi dapat dilakukan dengan berbagai metode yang secara garis besar

dibagi menjadi metode konvensional dan metode non-konvensional (Azmir dkk.,

2013).

2.7.1 Metode Ekstraksi Konvensional

a. Maserasi

Maserasi merupakan metode paling sederhana untuk melakukan ekstraksi.

Prinsip yang digunakan ialah melakukan perendaman serbuk simplisia dalam

cairan penyari. Cairan penyari akan menembus dinding sel kemudian masuk ke

dalam rongga sel yang mengandung senyawa bioaktif. Perbedaan konsentrasi

antara cairan penyari dan cairan di dalam sel membuat senyawa bioaktif terdesak

keluar, peristiwa tersebut berulang sehingga terjadi keseimbangan konsentrasi
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antara dalam sel dan luar sel. Maserasi digunakan untuk simplisia yang memiliki

senyawa bioaktif mudah larut dalam cairan penyari (Ningsih dkk., 2016).

Cairan penyari dapat dibagi menjadi beberapa golongan yaitu cairan

penyari polar, cairan penyari semi-polar, cairan penyari non-polar (Mukhriani,

2014).

i. Cairan penyari polar: air, etanol, metanol, dan sebagainya.

ii. Cairan penyari semi-polar: etil asetat, diklorometan, dan sebagainya.

iii. Cairan penyari non-polar: n-heksan, petroleum eter, kloroform, dan

sebagainya.

Keuntungan metode maserasi ialah peralatan yang digunakan sederhana

dan prosedurnya tidak terlalu rumit. Namun metode ini memakan waktu cukup

lama dan penyariannya kurang sempurna (Ningsih dkk., 2016)

b. Perkolasi

Pada metode ini, serbuk simplisia dibasahi secara perlahan dalam

perkolator (wadah silinder dengan kran pada bagian bawahnya). Cairan penyari

ditambahkan pada bagian atas serbuk simplisia dan dibiarkan menetes perlahan

pada bagian bawah yang akan menyebabkan senyawa bioaktif terlarut (Mukhriani,

2014; Ningsih dkk., 2016).

c. Soxhlet

Keuntungan dari metode soxhlet ialah proses ekstraksi yang kontinyu

sehingga tidak membutuhkan banyak cairan penyari dan menghemat waktu.

Prosesnya dimulai dengan meletakkan serbuk simplisia dalam sarung selulosa

atau kertas saring yang ditempatkan dalam klonsong (wadah seperti kaleng

dengan lubang-lubang kecil). Klonsong ini ditempatkan di atas labu distilasi yang

diisi cairan penyari. Ketika cairan penyari mulai meluap dari klonsong maka akan

dihisap dengan siphon/penghisap untuk dikembalikan ke dalam labu distilasi.

Ekstrak akan terbawa dan tertinggal dalam labu distilasi, proses ini berlangsung

terus-menerus hingga ekstraksi selesai (Azmir dkk., 2013; Mukhriani, 2014).

2.7.2 Metode Ekstraksi Non-Konvensional

a. Ultrasound-assisted Solvent Extraction
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Metode ini merupakan metode maserasi yang dimodifikasi menggunakan

bantuan ultrasound frekuensi tinggi . Ultrasound adalah gelombang suara diatas

ambang dengar manusia yaitu sekitar 20 kHz sampai 100 kHz. Tujuan

penggunaan ultrasound supaya sel tertekan secara mekanik sehingga membentuk

rongga pada sel dan menyebabkan peningkatan kelarutan senyawa bioaktif dalam

cairan penyari (Mukhriani, 2014). Gelombang ultrasound melewati medium

dengan berkompresi dan berekspansi. Proses tersebut akan menghasilkan

fenomena yang disebut kavitasi yang bermakna produksi, pertumbuhan, dan

pengempisan rongga. Yang memiliki efek kavitasi hanyalah material cair atau

material solid yang memiliki kandungan cairan. Keuntungan metode UAE antara

lain waktu ekstraksi lebih singkat, efektivitas penyampuran antara cairan penyari

dan simplisia, dan peningkatkan hasil ekstraksi (Azmir dkk., 2013).

b. Microwave-assisted Extraction (MAE)

Microwave adalah medan elektromagnetik dengan rentang frekuensi 3000

MHz sampai 300 GHz. Pertama, dilakukan pemisahan zat terlarut dari active site

matriks simplisia dengan peningkatan temperatur dan tekanan. Kedua, dilakukan

difusi oleh cairan penyari ke dalam matriks simplisia. Selanjutnya dilakukan

pengeluaran ekstrak dari matriks simplisia ke cairan penyari. Beberapa

keuntungan dari MAE yaitu pemanasan yang cepat untuk mengekstraksi senyawa

bioaktif dari simplisia, mengurangi gradien termal, meningkatkan jumlah ekstrak.

MAE digolongkan sebagai green technology karena mengurangi pemakaian

cairan penyari organik (Azmir dkk., 2013).

2.8 Tinjauan Umum Metode Pembuatan Fraksi

Pembuatan fraksi dilakukan untuk memisahkan senyawa yang memiliki

polaritas dan ukuran molekul yang sama karena proses ekstraksi hanya

menghasilkan campuran berbagai senyawa (Mukhriani, 2014). Pemisahan

senyawa tersebut dibagi menjadi pemisahan kasar dan pemisahan halus.

2.8.1 Pemisahan Kasar

Hasil ekstraksi yang diperoleh masih kasar dan sangat kompleks isinya,

sehingga perlu dilakukan fraksinasi cair-cair atau partisi untuk memisahkan
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senyawa berdasarkan kepolaran larutan yang digunakan. Ekstrak metanol atau

etanol 70% umumnya dilarutkan dahulu ke dalam air hingga benar-benar larut

kemudian dilakukan partisi bertingkat menggunakan larutan sebagai berikut.

- Butanol

- Etil asetat

- Kloroform/diklorometana

- Heksan

Partisi cair-cair dilakukan dengan menggunakan corong pisah dimana

larutan yang digunakan adalah larutan yang memiliki perbedaan kepolaran.

Larutan organik yang digunakan dalam partisi akan berada di lapisan atas air

kecuali kloroform (Saifudin, 2014).

Gambar 2.4 Corong Pisah pada Proses Partisi Cair-Cair
(Moldoveanu dan David, 2015)

2.8.2 Pemisahan Halus

Teknik kromatografi sering dilakukan pada pemisahan hasil ekstraksi

tumbuhan. Teknik kromatografi merupakan metode fisik pemisahan berdasarkan

perbedaan afinitas senyawa-senyawa terhadap dua fasa yaitu fasa stasioner/fasa

diam dan fasa mobil/fasa gerak. Teknik kromatografi dibedakan menjadi beberapa

jenis berdasarkan sifat fasa-fasa yang digunakan, sifat fenomena yang terjadi pada

pemisahan, dan teknik pemisahan.

a. Berdasarkan sifat fasa-fasa yang digunakan:

1. Kromatografi cair-padat, denga fasa gerak cair dan fasa diam padat
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2. Kromatografi gas-padat, dengan fasa gerak gas dan fasa diam padat

3. Kromatografi cair-cair, dengan fasa gerak cair dan fasa diam cair

4. Kromatografi gas-cair, dengan fasa gerak gas dan fasa diam cair

b. Bedasarkan sifat fenomena yang terjadi pada pemisahan:

1. Kromatografi adsorbsi

2. Kromatografi partisi

3. Kromatografi lapis penukar ion

4. Kromatografi afinitas/filtrasi gel

c. Berdasarkan teknik pemisahan

1. Kromatografi Lapis Tipis (KLT)

Prinsip yang digunakan pada KLT ialah prinsip adsorbsi, dimana senyawa-

senyawa dengan kepolaran rendah akan terelusi lebih cepat dibandingkan

senyawa-senyawa polar. Hal tersebut disebabkan senyawa polar terikat lebih kuat

pada bahan silika yang mengandung silanol (SiOH2) yang memiliki afinitas kuat

terhadap senyawa polar (Endarini, 2016). Pada KLT pemisahan dilakukan

menggunakan lapisan tipis seragam yang disalutkan pada permukaan bidang datar

berupa lempeng kaca, plat alumunium, atau plat plastik yang bertindak sebagai

adsorben/fasa diam (Mukhriani, 2014). Sampel ditotolkan di atas fasa diam

menggunakan pipa kapiler (Endarini, 2016).

KLT digunakan untuk melihat kemurnian suatu senyawa organik,

menentukan banyaknya komponen dalam campuran, mencari pelarut yang sesuai

untuk kromatografi kolom, dan analisis fraksi-fraksi yang diperoleh dari

kromatografi kolom (Mukhriani, 2014; Endarini, 2016).

2. Kromatografi Kolom

Prinsip kromatografi kolom hampir sama dengan KLT yaitu menggunakan

prinsip adsorpsi. Sampel yang digunakan biasanya berupa larutan pekat. Sampel

ini diletakkan pada ujung kolom dan eluen/pelarut dialirkan secara kontinu ke

dalam kolom. Eluen melewati kolom karena gaya gravitasi dan proses pemisahan

akan terjadi. Eluen yang digunakan harus dimulai dari yang paling nonpolar

kemudian dinaikkan gradien kepolarannya hingga pemisahan terjadi. Pemisahan

dapat terjadi karena perbedaan afinitas antara senyawa pada adsorben dan eluen.
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Hal yang harus diperhatikan pada kromatografi kolom antara lain pemilihan

adsorben dan eluen, dimensi kolom yang digunakan serta kecepatan elusi

(Endarini, 2016).

3. Kromatografi Vakum Cair (KVC)

Metode ini digunakan unuk fraksinasi sampel dalam jumlah besar yaitu

10-50 gram. Sampel terlebih dahulu diadsorbsikan dalam silika kasar sebelum

dipisahkan agar lebih teratur dan mencegah sampel langsung menerobos dinding

kaca tanpa melewati adsorben dahulu. Kemudian kolom disambungkan dengan

penampung eluen yang disambungkan dengan pompa vakum. Eluen dengan

kepolaran rendah dituangkan ke permukaan penyerap yang sudah dimasuki

sampel. Penghisapan dilakukan perlahan menggunakan vakum. Elusi kolom

dilakukan dengan memilih elusi yang cocok. Eluen yang digunakan bertahap dari

nonpolar ke polar. Pompa vakum akan menghisap eluen dari kolom dan proses

pemisahan terjadi.  Penghisapan dilakukan sampai kering pada setiap

pengumpulan fraksi. Hasil pemisahan fraksi-fraksinya dikelompokkan menjadi

kelompok senyawa nonpolar, semipolar, dan polar (Atun, 2014).

2.9 Tinjauan Umum Metode Pembuatan Gel

2.9.1 Definisi Gel

Gel termasuk ke dalam bentuk sediaan semisolid yang dibuat dari partikel

anorganik kecil atau molekul organik besar yang dipenetrasikan oleh cairan

(Kementerian Kesehatan Republik Indonesia, 2014). Gel yang terbuat dari

material anorganik disebut sistem dua fase, dimana partikel kecil yang berlainan

tersebar di seluruh media dispersi. Ketika ukuran partikel lebih besar, maka

mereka disebut magma. Gel yang yang terbuat dari molekul organik disebut

sistem fase tunggal, dimana tidak ada ikatan antara molekul terdispersi dengan

medium dispersi. Medium dispersi yang biasa digunakan ialah cairan, meskipun

tidak jarang media berminyak maupun hidroalkoholik juga digunakan. Tidak

seperti suspensi dan emulsi, pergerakan dari molekul terdispersi terbatas pada gel

karena makromolekul organik terlarut atau interkoneksi jaringan tiga dimensi

partikel (Mahalingam dkk., 2008).
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2.9.2 Karakteristik Gel

Gel dapat menunjukkan sifat fisik yang berbeda-beda, yaitu imbibition,

swelling, syneresis, dan thixotropy. Imbibition merujuk pada penyerapan air atau

cairan lainnya oleh gel tanpa disertai peningkatan volume sementara swelling

merujuk pada peningkatan volume dikarenakan penyerapan air atau cairan

lainnya. Kedua sifat fisik yang ditunjukkan gel tersebut dipengaruhi oleh suhu,

pH, adanya elektrolit, dan bahan formulasi lainnya. Syneresis merujuk pada

kontraksi atau penyusutan gel akibat keluarnya medium dispersi dari matriks gel

karena pemelaran berlebihan dari makromolekul dan ekspansi selama swelling.

Pada kondisi setimbang, gel akan mempertahankan stabilitas fisiknya karena

kekuatan osmotik saat swelling menyeimbangi ekspansi kekuatan elastisitas

makromolekul. Pada keadaan suhu menurun, tekanan osmotik akan menurun

sehingga kekuatan elastisitas akan kembali normal, sehingga menghasilkan

penyusutan dari molekul yang meregang dan mengeluarkan medium dispersi dari

matriks gel. Penambahan agen osmotik seperti sukrosa, glukosa, dan elektrolit

lainnya dapat membantu mempertahankan tekanan osmotik meski dalam

temperatur rendah dan menghindari syneresis gel. Thixotropy merujuk pada aliran

alami non-Newtonian dalam gel yang memiliki karakteristik formasi reversibel

gel-to-sol tanpa perubahan volume maupun temperatur (Mahalingam dkk., 2008).

Sediaan gel biasanya diuji sifat fisiknya melalui uji sifat fisik gel untuk

menjamin sediaan masih memiliki sifat yang sama setelah sediaan dibuat dan

masih memenuhi kriteria. Ciri gel dengan ketidakstabilan fisik yaitu warna

memucat atau muncul warna baru, timbul bau, pemisahan fase, sineresis,

perubahan konsistensi, dan terdapat gas. Uji sifat fisik gel sebagai berikut

(Maulina dan Sugihartini, 2015; Sayuti, 2015).

a. uji organoleptik dan homogenitas

uji organoleptik dilakukan dengan mengidentifikasi secara langsung warna

dan aroma gel. Uji homogenitas dilakukan dengan mengoleskan gel pada kaca dan

dinyatakan homogen jika tidak ada butiran kasar pada sediaan (Maulina dan

Sugihartini, 2015; Sayuti, 2015).
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b. uji pH

uji pH dilakukan dengan mencelupkan kertas pH universal ke dalam

sampel gel yang telah diencerkan kemudian diamati perubahan warnanya dan

dicocokkan dengan standar pH universal (Maulina dan Sugihartini, 2015). Gel

dengan pH yang mendekati pH kulit yaitu sekitar 4,5-6,5 dapat digolongkan

sebagai gel yang baik (Sayuti, 2015).

c. Uji daya sebar

Gel diletakkan di atas kaca bulat sebanyak 0,5 gram kemudian ditumpuk

dengan kaca bulat lainnya selama 1 menit. Beban diletakkan diatas tumpukan

kaca bulat sebesar 150 gram lalu didiamkan lagi selama 1 menit dan diukur

diameter konstan gelnya (Maulina dan Sugihartini, 2015). Daya sebar gel yang

baik antara 5-7 cm (Sayuti, 2015).

d. Uji daya lekat

Gel sebanyak 0,25 gram diletakkan di antara dua gelas objek kemudian

ditekan menggunakan beban 1 kg selama 5 menit. Beban tersebut diangkat dan

diganti dengan beban 80 gram. Dua gelas objek dipisahkan dan waktunya dicatat

(Maulina dan Sugihartini, 2015).

e. Uji konsistensi

Gel disentrifugasi dengan kecepatan 3800 rpm selama 5 jam lalu diamati

perubahan fisiknya (Maulina dan Sugihartini, 2015).

2.9.3 Klasifikasi Gel

Gel diklasifikasikan menjadi hidrogel dan organogel berdasarkan karakter

fisik jenis material yang digunakan dalam proses dispersi (Mahalingam dkk.,

2008).

a. Hidrogel

Hidrogel menggunakan material atau koloid yang larut dalam air. Gum

natural dan sintetik seperti tragacanth, sodium alginate, dan pectin, material

anorganik seperti alumina, bentonite, silika, dan veegum, dan material organik

seperti polimer selulosa dapat membentuk hidrogel dalam air. Zat-zat tersebut

akan didispersi sebagai partikel koloid halus atau seutuhnya larut dalam air untuk
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membentuk struktur gel. Gum dan vehicles anorganik membentuk struktur gel

berdasarkan sifat peningkatan viskositas mereka. vehicles organik yang umumnya

derivate polimer selulosa dengat berat molekul tinggi membentuk struktur gel

karena sifat swelling yang dimiliki dan ikatan rantainya (Mahalingam dkk., 2008).

b. Organogel

Organogel dibuat menggunakan lipid yang tidak larut air seperti asam

lemak, yang menyebabkan pengembangan dalam air. Asam lemak yang umum

digunakan antara lain glycerol monooleate, glycerol monopalmito stearate, dan

glycerol monolinoleate. Zat-zat tersebut normalnya membentuk lilin dalam suhu

ruang dan membentuk kristal cairan dalam air serta meningkatkan viskositas

dispersi (Mahalingam dkk., 2008).

2.9.4 Persiapan dan Pengemasan Gel

Gel relatif lebih mudah untuk diproduksi, dibandingkan dengan salep dan

krim. Beberapa faktor berikut mempengaruhi persiapan dan pengemasan

(Mahalingam dkk., 2008).

a. Urutan Penyampuran Bahan

Urutan penyampuran bahan aktif dan bahan tambahan lain dengan vehicles

berdasarkan pada pengaruh vehicles pada proses pembentukan gel. Jika vehicles

mempercepat dan meningkatkan proses swelling, maka penyampuran vehicles

dilakukan setelah bahan aktif dan bahan tambahan lain dicampurkan. Idealnya

bahan aktif dan bahan tambahan lain dilarutkan menggunakan pelarut terlebih

dahulu, kemudian vehicles ditambahkan dan proses swelling akan terjadi

(Mahalingam dkk., 2008).

b. Kondisi Persiapan dan Durasi Swelling

Suhu, pH, dan durasi pada proses swelling sangat berpengaruh pada

persiapan pembuatan gel. Kondisi ini sangat tergantung dengan jenis vehicles,

contohnya air panas digunakan pada gelatin dan polyvinyl alcohol sementara air

dingin digunakan pada methylcellulose. Vehicles seperti carbomer, gum guar,

hydroxypropyl cellulose, poloxamer dan tragacanth membentuk gel dalam

kondisi pH asam lemah atau netral (pH 5-8). Vehicles seperti Na CMC,
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hydroxypropylmethyl cellulose, dan sodium alginate membentuk gel dalam

kondisi pH dengan rentang cukup luas (pH 4-10).

c. Pengeluaran Udara

Gelembung udara yang terperangkap dalam matriks gel sering menjadi

masalah, terlebih jika terjadi swelling dalam proses penyampuran bahan aktif dan

bahan tambahan. Penyimpanan dalam suhu rendah, sonikasi, atau pemberian agen

antifoaming silicon dapat dilakukan untuk mengeluarkan gelembung udara yang

terperangkap.

2.9.5 Manfaat Penggunaan Gel

Pembuatan gel mudah dan cocok digunakan sebagai obat dengan

pengaplikasian secara topikal, bukal, optalmikal, nasal, telinga, dan vaginal. Hal

ini dikarenakan gel meningkatkan kontak antara bahan aktif dengan situs aksi dari

penyerapan (Mahalingam dkk., 2008).  Selain itu, gel juga mudah mengering,

memberi sensasi dingin pada bagian yang diolesi serta membentuk lapisan film

yang mudah dibilas (Sayuti, 2015).

2.9.6 Definisi Vehicles

Vehicles merupakan senyawa dengan berat molekul tinggi yang tersusun

dari bahan alam maupun secara sintetis. Vehicles dapat larut dalam air, memiliki

sifat swelling, dan meningkatkan viskositas dispersi. Vehicles yang ideal adalah

vehicles yang tidak berinteraksi dengan komponen formulasi lain karena sifatnya

sebagai pembentuk gel, serta bebas dari pengaruh mikroba (Mahalingam dkk.,

2008).

2.9.7 Peran Vehicles dalam Gel

Pembuatan gel membutuhkan vehicles karena menentukan sifat fisika gel,

memberikan sensasi dingin pada daerah pengaplikasian, dan memberikan aroma

yang baik (Mahalingam dkk., 2008). Berdasarkan faktor-faktor tersebut,

pemilihan vehicles sangat tergantung pada tujuan formulasinya. Macam-macam

vehicles sebagai berikut.
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a. Carbomer

Carbomer sangat sering digunakan sebagai vehicle dalam pembuatan gel

topikal karena sifat fisik swelling yang tinggi. Nama lain dari carbomer ialah

carbopol. Carbomer dapat dibentuk melalui cross-linking acrylic acid dengan

allyl sucrose atau allyl pentaerythritol. Carbomer tersedia dalam bentuk bubuk

higroskopik berwarna putih, namun menjadi tidak berwarna ketika digunakan

dalam formulasi gel. Dispersi cair carbomer memiliki viskositas rendah dan butuh

dinetralisir untuk membentuk gel dengan tingkat kekentalan tinggi. Material

seperti sodium hydroxide, sodium bicarbonate, dan borax digunakan untuk

menetralisir dispersi carbomer. Kurang lebih sebanyak 0,4 gram sodium

hydroxide digunakan untuk menetralisir dispersi 1 gram carbomer. Namun

viskositas gel juga tergantung pada berat molekul carbomer dan data cross-

linking, termasuk penggunaan antioksidan, perlindungan dari cahaya,

penyimpanan dalam suhu ruang. Faktor-faktor tersebut membantu untuk

memperpanjang waktu dalam mempertahankan viskositasnya. Gel carbomer

rentan terhadap perubahan warna pada keberadaaan sejumlah besar elektrolit,

asam kuat, dan polimer kationik. Kaca, plastik, dan wadah berlapis resin yang

memiliki sifat tahan korosi baik digunakan untuk mengemas gel carbomer

(Mahalingam dkk., 2008) .

b. Carboxymethylcellulose Sodium (Na CMC)

Na CMC merupakan garam selulosa sodium polycarbomethyl ether yang

dibentuk dengan menyampurkan alkaline cellulose dengan sodium

monochloroacetate. Na CMC tersedia dalam bentuk bubuk granular berwarna

putih dan menjadi tidak berwarna ketika dilarutkan dalam air. Banyak jenis Na

CMC dipasarkan secara luas berdasarkan tingkat viskositasnya. Perbedaan tingkat

viskositas tersebut disebabkan oleh tingkat substitusi yang merepresentasikan

rata-rata jumlah grup hydroxyl yang tersubstitusi dalam tiap unit anhydroglucose.

Selain itu, tingkat substitusi juga menentukan kelarutan Na CMC. Viskositas gel

Na CMC terjaga dalam kondisi pH netral, dan akan mengalami penurunan pada

pH dibawah 2 atau diatas 10. Viskositas gel Na CMC juga mengalami penurunan
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pada kondisi suhu yang meningkat. Kekentalan gel Na CMC berbanding lurus

dengan jumlah konsentrasinya (Mahalingam dkk., 2008).

c. Hydroxypropylmethyl Cellulose (HPMC)

HPMC dibentuk dengan penyampuran chloromethane dan propylene

oxide. HPMC tersedia dalam bubuk berwarna putih hingga putih kekuningan,

tidak memiliki rasa dan tidak memiliki aroma. HPMC terlarut dalam air dingin.

Persiapan dispersi cair HPMC menggunakan 25% air panas dengan pengadukan

kuat, baru setelah mengalami hidrasi komplit air dingin dimasukkan dan

dicampurkan. Viskositas gel HPMC tergantung pada konsentrasi material yang

digunakan dan berat molekulnya, penambahan pelarut organik seperti etanol atau

dichloromethane meningkatkan viskositas (Mahalingam dkk., 2008).
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2.10 Kerangka Konsep

Gambar 2.5 Kerangka Teori
(Velnar dkk., 2009; Guo dan Dipietro, 2010; Hidayat dkk., 2015; Prameswari,

2017)

Luka diabetik menjadi salah satu komplikasi DM yang menjadi beban karena

resiko amputasi tinggi, sebesar 11,2% dari 5,8% pasien DM harus menjalani

amputasi (Hidayat dkk., 2015). Proses penyembuhan luka terdiri dari 4 fase, yaitu

fase hemostasis, fase inflamasi, fase proliferasi, dan fase remodeling (Velnar dkk.,

2009). Pada luka diabetik, keempat fase ini terlambat karena adanya hipoksia
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jaringan, disfungsi sel epidermal dan fibroblas, angiogenesis tidak sempurna,

penurunan resistensi imun dan  neuropati (Guo dan Dipietro, 2010). Umbi bidara

upas (Merremia mammosa (Lour.)) memiliki senyawa aktif flavonoid dan

glikosida resin yang berfungsi sebagai antioksidan dan antibakteri. Pada penelitian

oleh Prameswari (2017), dilakukan fraksinasi ekstrak umbi bidara upas (Merremia

mammosa (Lour.)) dan terdapat pengaruh penyembuhan luka yang terlihat secara

mikroskopis yaitu meningkatnya kepadatan kolagen pada luka diabetik. Pada

proses penyembuhan luka diabetik kelembapan mejadi salah satu faktor penting,

salah satu caranya dengan menggunakan sediaan gel topikal. Vehicles dalam gel

memiliki peranan penting dalam signifikansi absorbsi bahan aktif obat, serta

menjaga kelembaban jaringan sehingga memicu proses terjadinya reepitalisasi

jaringan melalui stimulasi proliferasi dan migrasi sel epitel serta peningkatan

aktivitas growth factor yang nantinya akan memicu peningkatan sintesis kolagen.

Kolagen berperan penting dalam proses penyembuhan luka karena

mengembalikan integritas dan kekuatan jaringan. Peningkatan kepadatan kolagen

akan mengecilkan luka (Velnar dkk., 2009).

2.11 Hipotesis

Hipotesis yang diajukan dalam penelitian ini adalah terdapat pengaruh

perbedaan bahan pembawa/vehicles HPMC, Carbopol, dan Na CMC dalam gel

fraksi air ekstrak umbi bidara upas (Merremia mammosa (Lour.)) terhadap

kepadatan kolagen pada penyembuhan luka diabetik.

Digital Repository Universitas JemberDigital Repository Universitas Jember

http://repository.unej.ac.id/
http://repository.unej.ac.id/


32

BAB 3. METODE PENELITIAN

3.1 Jenis Penelitian

Jenis penelitian yang digunakan dalam penelitian ini ialah true

experimental laboratories karena dilakukan randomisasi dalam menentukan

sampel, terdapat replikasi, dan terdapat kontrol internal.

3.2 Rancangan Penelitian

Rancangan penelitian yang digunakan dalam penelitian ini ialah posttest-

only control group design. Rancangan penelitian secara sistematis dapat dilihat

pada Gambar 3.1.

Gambar 3.1 Skema Rancangan Penelitian

Keterangan:

Po : Populasi

S : Sampel

R : Randomisasi

K- : Kelompok kontrol negatif luka diolesi Akuades

K+ : Kelompok kontrol positif 1 luka diolesi gel Bioplacenton®

P1 : Kelompok perlakuan 1 luka diolesi gel fraksi air ekstrak umbi bidara

upas dengan vehicle HPMC

P2 : Kelompok perlakuan 1 luka diolesi gel fraksi air ekstrak umbi bidara

upas dengan vehicle Carbopol
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P3 : Kelompok perlakuan 1 luka diolesi gel fraksi air ekstrak umbi bidara

upas dengan vehicle Na CMC

OK+ : Observasi kelompok kontrol positif (pengamatan histoPA kepadatan

kolagen luka pada jaringan kulit tikus)

OK- : Observasi kelompok kontrol negatif (pengamatan histoPA kepadatan

kolagen luka pada jaringan kulit tikus)

OP1 : Observasi kelompok perlakuan 1 (pengamatan histoPA kepadatan

kolagen luka pada jaringan kulit tikus)

OP2 : Observasi kelompok perlakuan 2 (pengamatan histoPA kepadatan

kolagen luka pada jaringan kulit tikus)

OP3 : Observasi kelompok perlakuan 3 (pengamatan histoPA kepadatan

kolagen luka pada jaringan kulit tikus)

3.3 Populasi dan Sampel

3.3.1 Populasi

Populasi dalam penelitian ini ialah tikus putih jantan galur Wistar dari

peternakan di Surabaya.

3.3.2 Sampel

Dalam penelitian ini digunakan sampel tikus putih jantan galur Wistar

dengan usia 2-3 bulan dan berat antara 150-220 gram.

3.3.3 Besar Sampel Penelitian

Pengambilan sampel dalam penelitian ini meggunakan teknik random

bertingkat (stratified random sampling) dari populasi tikus putih jantan galur

Wistar yang diinduksi DM yang akan dibagi dalam 5 kelompok. Besar sampel

dihitung menggunakan rumus Resource Equation sebagai berikut.

Minimum n = DF/k + 1

= 10/5 + 1

= 3

Maximum n = DF/k + 1
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= 20/5 + 1

= 5

n = jumlah sampel tiap grup

k = jumlah grup

DF = degree of freedom

Berdasarkan rumus tersebut, jumlah perlakuan dalam penelitian ini dibagi

menjadi 5 kelompok dengan jumlah sampel minimal 3 pada tiap kelompok dan

maksimal 5, sehingga sampel yang diambil sebanyak 4 ekor dalam satu kelompok

atau berjumlah total 20 ekor tikus. Sampel yang digunakan memiliki kriteria

inklusi dan eksklusi sebagai berikut.

a. Kriteria inklusi

1. Tikus galur Wistar

2. Berjenis kelamin jantan

3. Usia 2-3 bulan

4. Berat badan 150-220 gram

5. Tidak memiliki kelainan anatomis

6. Sehat dan aktif selama masa adaptasi

7. Kadar glukosa darah > 200 mg/dL

b. Kriteria eksklusi

1. Mati selama penelitian

2. Sakit selama masa adaptasi (tidak bergerak aktif)

3.4 Tempat dan Waktu Penelitian

Pada penelitian ini pembuatan fraksi air ekstrak etanol umbi bidara upas

(Merremia mammosa (Lour.)) dilakukan di Laboratorium Biologi Fakultas

Farmasi Universitas Jember. Pemeliharaan dan pemberian perlakuan terhadap

sampel dilakukan di Laboratorium Farmakologi Fakultas Kedokteran Universitas

Jember. Pembuatan sediaan preparat histoPA dilakukan di Laboratorium Patologi

Anatomi Fakultas Kedokteran Universitas Airlangga, Surabaya. Pengamatan

kepadatan kolagen dilakukan di Laboratorium Biomedik Fakultas Farmasi
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Universitas Jember. Penelitiaan ini dilakukan selama bulan April sampai Juni

2018 meliputi masa adaptasi hingga terminasi.

3.5 Variabel

3.5.1 Variabel Bebas

Variabel bebas pada penelitian ini ialah jenis vehicle HPMC, Carbopol, dan

Na CMC dalam gel fraksi air ekstrak etanol umbi bidara upas (Merremia

mammosa (Lour.)).

3.5.2 Variabel Terikat

Variabel terikat pada penelitian ini ialah kepadatan kolagen pada luka

diabetik kulit tikus.

3.5.3 Variabel Terkendali

Variabel terkendali dalam penelitian ini sebagai berikut.

1. Usia tikus

2. Jenis kelamin tikus

3. Berat badan tikus

4. Adaptasi dan pemeliharaan terhadap tikus

5. Rentang waktu perlakuan terhadap tikus

6. Dosis streptozotocin (STZ) 40 mg/kgBB

7. Dosis dextrose 10% 50 mL
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3.6 Definisi Operasional

Tabel 3.1 Definisi Operasional Variabel Bebas dan Terikat
No Variabel Definisi Operasional Hasil Ukur Skala Ukur
1. Jenis Vehicles Bahan dasar pembentuk gel terdiri dari

HPMC, Carbopol, dan Na CMC.
Masing-masing Vehicle membentuk
sediaan gel melalui proses homogenisasi
dengan bahan aktif (fraksi air ektrak
etanol umbi bidara upas (Merremia
mammosa (Lour.)) trietanolamin
alkalizing agent, propilen glikol
kosolven, dan akuades pembawa yang
menghasilkan total bahan 100 gram.

Jenis vehicle Nominal

2. gel fraksi air
ektrak umbi
bidara upas
(Merremia
mammosa
(Lour.))

Sediaan topikal berbentuk gel dengan
bahan aktif fraksi air dari umbi bidara
upas (Merremia mammosa (Lour.))
yang telah diekstraksi menggunakan
etanol.

Nominal

3. Kepadatan
Kolagen

Presentase luas serabut kolagen pada
sediaan preparat histopatologi luka tikus
yang diberi pewarnaan spesifik kolagen
Masson’s trichome dan diamati
menggunakan mikroskop dengan
perbesaran 400x kemudian dilakukan
pengambilan gambar. Gambar diolah
menggunakan software ImageJ
(Prameswari, 2017).

Presentase serabut
kolagen tiap luas
luka

Rasio

4. Luka
Diabetik

Perlukaan yang diberikan menurut
metode Morton, yaitu dengan eksisi kulit
hingga lapisan subkutan beserta jaringan
ikat di bawahnya di area punggung tikus
model diabetes, luka berbentuk persegi
berukuran 2 cm x 2 cm (Prameswari,
2017; Sakinah dkk., 2018)

Rasio

3.7 Alat dan Bahan

3.7.1 Alat Penelitian

Pada penelitian ini menggunakan alat sebagai berikut.

a. Alat untuk pemeliharaan tikus antara lain bak plastik, penutup kawan yang

dilapisi kasa, alas jaring-jaring kawat, tempat makan, botol minum, dan

label nama.

b. Alat yang digunakan untuk pembuatan gel fraksi air ekstrak umbi bidara

upas antara lain blender, ayakan, beaker glass, timbangan, corong

Buchner, rotator evaporator, maserator, freeze dryer, handscoon, dan

batang pengaduk.

Digital Repository Universitas JemberDigital Repository Universitas Jember

http://repository.unej.ac.id/
http://repository.unej.ac.id/


37

c. Alat untuk penginjeksian STZ antara lain beaker glass, batang pengaduk,

spuit, neraca ohaus, dan handscoon.

d. Alat untuk pembuatan Dextrose 10% antara lain beaker glass, timbangan,

batang pengaduk, dan botol minum 50mL.

e. Alat untuk memeriksa glukosa darah tikus antara lain gunting bedah,

glucotest dan stik glukosa.

f. Alat untuk melakukan eksisi luka pada punggung tikus antara lain spuit,

stempel cetakan luka 2 cm x 2 cm, alat bedah, dan handscoon.

g. Akat untuk mengoleskan gel terhadap luka antara lain wadah gel dan

handscoon.

h. Alat untuk mengambil jaringan kulit pada hari ke-26 antara lain alat

bedah, tempat fiksasi, dan handscoon.

i. Alat pengamatan preparat histoPA jaringan kulit antara lain mikroskop,

kamera, laptop, dan software imageJ.

3.7.2 Bahan Pengamatan

Pada penelitian ini menggunakan bahan sebagai berikut.

a. Bahan untuk pemeliharaan tikus antara lain pakan turbo dan sekam kering.

b. Bahan untuk pembuatan gel fraksi air ekstrak etanol umbi bidara upas

antara lain etanol 70%, akuades, HPMC, Carbopol, dan Na CMC.

c. Bahan untuk injeksi STZ antara lain STZ dan buffer sitrat.

d. Bahan untuk pembuatan Dextrose 10% antara lain bubuk glukosa dan

akuades.

e. Bahan untuk pemeriksaan glukosa darah tikus antara lain dan darah dari

ekor tikus yang digunting ± 0,5 cm.

f. Bahan untuk anestesi tikus antara lain ketamine dan xylazin.

g. Bahan untuk mengoleskan gel terhadap luka antara lain gel fraksi air

ekstrak umbi bidara upas dan Bioplacenton.

h. Bahan untuk anestesi tikus saat mengambil jaringan kulit pada hari ke-26

antara lain eter dan buffer formalin 10%.
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i. Bahan pembuatan preparat histoPA jaringan kulit ialah Masson’s trichome

kit.

3.8 Prosedur Penelitian

3.8.1 Uji Kelayakan Etik

Dalam penelitian ini dibutuhkan uji kelayakan etik untuk menjamin

keamanan bagi peneliti, subjek penelitian yaitu tikus sebagai hewan coba, serta

memperjelas tujuan dan kewajiban peneliti. Uji kelayakan etik diajukan kepada

komisi etik Fakultas Kedokteran Universitas Jember.

3.8.2 Pemilihan Hewan Coba

Hewan coba didapatkan dari peternakan di Jember sebanyak 20 ekor tikus

putih jantan galur Wistar (Rattus wistar). Jumlah tersebut dibagi menjadi 5

kelompok secara random dengan menyesuaikan kriteria inklusi.

3.8.3 Adaptasi Hewan Coba

Adaptasi tikus dilakukan selama 7 hari di Laboratorium Farmakologi

Fakultas Kedokteran Universitas Jember. Selama masa adaptasi, tikus diberikan

makanan dan minuman secara ad libitum.

3.8.4 Pembagia Kelompok Perlakuan

Pembagian kelompok tikus beserta perlakuan yang diberikan dapat dilihat

pada Tabel 3.2 berikut.
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Tabel 3.2 Pembagian Kelompok Perlakuan
Nama Kelompok Perlakuan yang Diberikan

Kelompok K- Pemberian akuades
Kelompok K+ Pemberian gel Bioplacenton®
Kelompok P1 Pemberian gel fraksi air ekstrak etanol umbi bidara upas

dengan vehicle HPMC
Kelompok P2 Pemberian gel fraksi air ekstrak etanol umbi bidara upas

dengan vehicle Carbopol
Kelompok P3 Pemberian gel fraksi air ekstrak etanol umbi bidara upas

dengan vehicle Na CMC

3.8.5 Pembuatan Ekstrak Etanol Umbi Bidara Upas

Pembuatan ekstrak etanol umbi bidara upas (Merremia mammosa (Lour.))

sesuai dengan prosedur ekstraksi metode ultrasonik yang dilakukan di

Laboratorium Biologi Fakultas Farmasi Universitas Jember. Umbi bidara upas

(Merremia mammosa (Lour.)) segar 10 kg dibersihkan tanpa dikupas kemudian

dipotong-potong dan dikeringkan dengan diangin-anginkan atau dioven suhu 60º

Celcius. Kemudian umbi bidara upas (Merremia mammosa (Lour.)) yang telah

kering dihaluskan dengan blender. Selanjutnya umbi bidara upas (Merremia

mammosa (Lour.)) sebanyak 1 kg diekstraksi dengan ultrasonik menggunakan

methanol 70 % 5 Liter (perbandingan 1:5) selama 1 jam dengan sesekali diaduk.

Setelah 1 jam, filtrat hasil diambil dengan penyaringan menggunakan corong

Buchner. Residu di ekstraksi kembali dengan ultrasonik menggunakan etanol 70%

sebanyak 5 Liter selama 1 jam dengan sesekali diaduk. Filtrat diambil dengan

penyaringan menggunakan Buchner dan digabungkan dengan filtrat sebelumnya.

Filtrat yang telah diperoleh selanjutnya dipekatkan dengan rotary evaporator

sehingga didapatkan ekstrak etanol. Ekstrak yang diperoleh dikentalkan dengan

penguapan diatas water bath sehingga didapatkan ekstrak etanol kental.

3.8.6 Pembuatan Fraksi Air Umbi Bidara Upas

Pembuatan fraksi air ekstrak etanol umbi bidara upas (Merremia

mammosa (Lour.)) sesuai dengan prosedur fraksinasi ekstrak yang dilakukan di

Laboratorium Biologi Fakultas Farmasi Universitas Jember. Tata cara pembuatan

fraksi air sebagai berikut.
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1. Sebanyak 120 Gram ekstrak etanol kental ditambahkan dengan 240 mL

akuades dan diaduk hingga tercampur, kemudian dimasukkan ke dalam

corong pisah.

2. Ke dalam campuran ekstrak dan air ditambahkan n-heksana 360 mL

(perbandingan 1:3) dan dikocok kuat selama 30 menit dan didiamkan

sampai lapisan n-heksana dan air terpisah sempurna. Lapisan n-heksana

(bagian atas) diambil melalui lubang atas setelah lapisan air dikeluarkan

melalui kran bawah. Tahap ini diulang dua kali.

3. Sisa lapisan air diukur volumenya dan dimasukkan ke dalam corong pisah

kemudian ditambahkan dengan etil asetat perbandingan 1:3.

4. Campuran dikocok kuat selama 30 menit dan didiamkan sampai lapisan

etil asetat dan air terpisah sempurna. Lapisan etil asetat (bagian atas)

diambil melalui lubang atas setelah lapisan air dikeluarkan melalui kran

bawah. Tahap ini diulang dua kali.

5. Lapisan air dipekatkan dengan freeze drying setelah dipisahkan dari residu

ekstrak etanol yang tidak larut air.

6. Hasil freeze drying (fraksi air umbi bidara upas (Merremia mammosa

(Lour.))) ditimbang dan digunakan untuk formulasi gel.

3.8.7 Pembuatan Gel Fraksi Air Umbi Bidara Upas

Gel dibuat dengan mencampurkan basis gel dengan fraksi. Vehicles atau

pembawa dalam gel dibedakan menjadi 3 jenis (HPMC, Carbopol, dan Na CMC).

Formula pembuatan gel dapat dilihat dalam Tabel 3.3 berikut.

Tabel 3.3 Formula Pembuatan Gel

Bahan Fungsi Formulasi I Formulasi II Formulasi III
HPMC Vehicle 1,5 g - -

Carbopol Vehicle - 1,5 g -
Na CMC Vehicle - - 5 g

Trietanolamin Alkalizing agent 0,5 g 0,5 g 0,5 g

Propilen glikol Kosolven 20 g 20 g 20 g

Fraksi Bahan aktif 10 g 10 g 10 g

Akuades Pelarut 68 g 68 g 64,5 g
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Proses pembuatan basis gel dimulai dengan mengembangkan vehicle

dalam air panas dalam mortir, kemudian diaduk hingga homogen lalu

ditambahkan trietanolamin (TEA) sedikit demi sedikit hingga terbentuk massa

gel. Fraksi air ekstrak etanol umbi bidara upas (Merremia mammosa (Lour.))

dicampurkan dengan propilen glikiol hingga homogen, kemudian dicampurkan ke

dalam basis gel dan diaduk sampai homogen. Sisa akuades ditambahkan ke dalam

gel sedikit demi sedikit hingga homogen.

3.8.8 Penginduksian Streptozotocin (STZ)

Setelah diadaptasikan selama 7 hari, tikus diinduksi streptozotosin (STZ)

40 mg/kgBB yang dilarutkan dalam 0,05 mol/L buffer sitrat (pH 4,5) secara

intraperitonial. Kemudian, setiap tikus diberikan dextrose 10% selama 24 jam

setelah induksi STZ secara ad libitum menggunakan botol minum 50mL untuk

menghindari hypoglycemic sudden death (Sakinah dkk., 2018). Dextrose 10%

dibuat dengan melarutkan 100 gram bubuk glukosa ke dalam 1000 mL larutan

akuades.

3.8.9 Pemeriksaan Kadar Glukosa Darah

Kadar gula darah tikus diperiksa menggunakan glucotest dan stik glukosa.

Pertama ekor tikus digunting menggunakan gunting bedah sepanjang ± 0,25 cm,

kemudian darahnya diteteskan pada stik glukosa yang telah disambungkan dengan

glucotest. Hasil kadar gula darah tikus akan muncul secara otomatis dalam 10

detik. Tikus dinyatakan positif diabetes jika  kadarnya ≥ 200 mg/dL 5 hari setelah

injeksi STZ (Sakinah dkk., 2018). Kadar gula darah diperiksa tiga kali pada hari

ke-7, 13 dan 25..

3.8.10 Eksisi Luka Jaringan Kulit

Luka diabetik dibuat melalui eksisi jaringan kulit pada punggung tikus.

Mula-mula tikus dianestesi menggunakan kombinasi ketamine HCl dosis 50

mg/kgBB dan Xylazine dosis 10 mg/kgBB secara intramuscular. Kemudian
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rambut di punggung tikus dicukur dan diberi cetakan luka berbentuk persegi

dengan ukuran 2 cm x 2 cm (Liu dkk., 2013; Sakinah dkk., 2018). Eksisi

dilakukan dengan mengikuti bentuk cetakan hingga lapisan epidermis dan lapisan

subkutan serta jaringan ikat di bawahnya terangkat (Prameswari, 2017).

3.8.11 Pengolesan Gel Fraksi Air Ekstrak Etanol Umbi Bidara Upas

Pengolesan gel dilakukan setiap 2 hari sekali dimulai 24 jam sejak

dilakukannya eksisi luka atau pada hari ke-15 sampai hari ke-24. Mula-mula luka

dioles menggunakan akuades untuk membersihkan luka dari kotoran maupun sisa

gel sebelumnya, lalu aplikasikan gel dalam sekali oles.

3.8.12 Pengambilan Jaringan Kulit

Pada hari ke-25 jaringan kulit yang luka diambil, mula-mula tikus

diterminasi dengan pemberian anestesi inhalasi eter. Jaringan kulit yang luka

kemudian dieksisi secara melintang dan disimpan di dalam botol yang berisi

cairan buffer formalin 10% (Prameswari, 2017; Marchianti dkk., 2018).

3.8.13 Pembuatan Preparat HistoPA

Pembuatan preparat jaringan kulit tikus dilakukan di Laboratorium

Patologi Anatomi Fakultas Kedokteran Universitas Airlangga, Surabaya. Teknik

pembuatan preparat histoPA menggunakan pewarnaan Masson’s trichome yang

spesifik untuk kolagen dengan memberi warna biru atau hijau terang pada serabut

kolagen. Teknik yang dilakukan sebagai berikut.

a. Fiksasi

Jaringan kulit dimasukkan dalam larutan formalin buffer (formalin 10%

dalam phospat buffer salin pada pH 7,0) selama 18-24 jam. Setelah itu jaringan

dimasukkan dalam akuades selama 1 jam supaya larutan fiksasi hilang.

b. Dehidrasi

Jaringan dimasukkan dalam alcohol konsentrasi bertingkat yang akan

membuat jaringan lebih jernih dan transparan. Kemudian jaringan dimasukkan
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dalam larutan alcohol-xylol selama 1 jam, dilanjutkan dengan larutan xylol murni

selama 2x2 jam.

c. Impregnasi

Potongan jaringan dimasukkan dalam paraffin cair selama 2x2 jam.

d. Embedding

Potongan jaringan dimasukkan dalam paraffin cair dengan titik lebur 56-

58ºC dan ditunggu sampai paraffin menjadi padat. Jaringan dalam paraffin

kemudian dipotong setebal 4 mikron dengan alat mikrotom. Potongan jaringan

ditempelkan diatas objek glass yang telah diolesi polilisin sebagai perekat.

Selanjutnya jaringan pada kaca objek dipanaskan di dalan incubator suhu 56-58ºC

sampai paraffin mencair.

e. Pewarnaan menggunakan metode Masson’s trichome

Preparat difiksasi dengan formalin 10% lalu dilakukan deparafinisasi

menggunakan akuades, dimasukkan dalam larutan boin’s selama 1 jam pada suhu

56 ºC, didinginkan dan cuci dengan air mengalir sampai warna kuningnya

menghilang, lalu bilas dengan akuades. Preparat dimasukkan ke dalam larutan

weigert’s iron hematoxylin selama 10 menit lalu cuci dengan air mengalir selama

10 menit, kemudian bilas dengan akuades. Rendam dalam larutan biebrich

scarlet-acid fuchisin selama 2 menit, bilas kembali dengan akuades, dimasukkan

ke dalam asam phosphomolybdic-phosphotungstic selama 10 menit lalu lanjutkan

dengan larutan methyl blue selama 5 menit, bilas kembali akuades, dan masukkan

dalam larutan asam glasial asetat selama 3 menit. Langkah terakhir dehidrasi

dengan alcohol 95-100%, bersihkan dengan xylene sebanyak dua kali, lalu

lakukan mounting dengan kanada balsam (Suvik, 2012; Prameswari, 2017).

3.8.15 Pengamatan Kepadatan Kolagen

Pengamatan dilakukan dengan pengawasan ahli Patologi Anatomi. Lokasi

pengamatan kolagen yaitu di daerah bekas luka eksisi. Pengamatan dilakukan

dengan perbesaran 400x pada 6 lapang pandang lalu dilakukan pengambilan

gambar menggunakan optilab. Selanjutnya presentase kepadatan kolagen diukur

menggunakan software imageJ (Prameswari, 2017).
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3.9 Analisis Data

Penelitian ini menggunakan program analisis statistik. Uji hipotesis yang

digunakan ialah uji komparatif numerik tidak berpasangan. Sebelum dilakukan uji

statistik, dilakukan uji normalitas dengan uji Shapiro Wilk karena sampel kurang

dari 50, kemudian mencari kesamaan varian atau homogenitas menggunakan

Levene’s test. Apabila data terdistribusi normal dengan varian sama maka

dilakukan uji One Way Annova (p<0,05) dilanjutkan uji Post Hoc Fisher’s LSD

(p<0,05), apabila tidak maka dilakukan uji Kruskal-Wallis (p<0,05) dan

dilanjutkan uji Post Hoc Mann-Whitney (p<0,05).
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10 kg umbi bidara upas (Merremia mammosa (Lour.))

Dikeringkan

Diblender

Diayak

1 kg serbuk simplisia

Diekstraksi dengan ultrasound menggunakan pelarut etanol 70% 5L

Disaring dengan corong Bucher

Filtrat Residu

Diuapkan dengan rotary evaporator

Ekstrak kental

3.10 Alur Penelitian

Penelitian ini memiliki beberapa tahap yang akan dijelaskan dalam skema

berikut.

a. Skema Proses Ekstraksi Umbi Bidara Upas

Gambar 3.2 Skema Proses Ekstraksi Umbi Bidara Upas
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Gambar 3.3 Skema Proses Fraksinasi Ekstrak Umbi Bidara Upas

b. Skema Proses Fraksinasi Ekstrak Umbi Bidara Upas

Dimasukkan ke corong
pisah, dikocok 2-5 menit

lalu didiamkan

120 gram ekstrak kental

Ditambahkan 240 mL
akuades, diaduk sampai

homogen

360 mL n-heksana

Dimasukkan ke corong
pisah, dikocok 2-5 menit

lalu didiamkan

Lapisan air Lapisan n-heksana

Fraksi n-heksana

Lapisan air

Ditambahkan 360 mL etil
asetat

Lapisan etil asetat

Freeze drying

Fraksi air

Diuapkan dengan rotary

evaporator

Fraksi etil asetat

Pengulangan 2 kali

Pengulangan 2

kali
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c. Skema Pembuatan Gel Fraksi Air Ekstrak Etanol Umbi Bidara Upas

10 g fraksi ekstrak
umbi bidara upas

1,5 g Vehicle HPMC 1,5 g Vehicle Carbopol 5 g Vehicle Na CMC

Masing-masing dikembangkan dalam
air panas

Masing-masing diaduk hingga
homogen

Masing-masing ditambahkan
trietanolamin (TEA) 0,5 g

Masing-masing diaduk hingga
terbentuk massa gel

Dicampur 20 g
propilen glikol

Dicampur dan
diaduk

Ditambahkan akuades, diaduk
hingga homogen

Gel fraksi air ekstrak
etanol umbi bidara upas
dengan vehicle HPMC

Gel fraksi air ekstrak
etanol umbi bidara upas
dengan vehicle Carbopol

Gel fraksi air ekstrak
etanol umbi bidara upas
dengan vehicle Na CMC

Gambar 3.4 Skema Pembuatan Gel Fraksi Air Ekstrak Etanol Umbi Bidara Upas
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d. Skema Proses Penyembuhan Luka Diabetik

Gambar 3.5 Skema Proses Penyembuhan Luka Diabetik

Bioplacenton Gel

dengan

vehicle

HPMC

Akuades Gel

dengan

vehicle Na

CMC

Gel

dengan

vehicle

Carbopol

Eksklusi:
-Mati
-Tidak aktif selama
masa adaptasi (tidak
bergerak aktif)

Adaptasi

Induksi STZ

Pemeriksaan glukosa

Randomisasi 20 tikus putih

jantan

Dilakukan eksisi luka

Pemeriksaan glukosa

Pengambilan jaringan kulit

Pembuatan preparat histoPA

Pengamatan histologi kepadatan
kolagen

Analisis statistika

Hari 1-7

Hari 13

Hari 13

Hari 14

Hari 8

Hari 15-24

Hari 25

Pemberian Dextrose 10% 24 jam

Inklusi:
-Berat badan 150-220
gram
-Sehat dan aktif selama
masa adaptasi
-Kadar glukosa darah ≥
200 mg/dL

Hari 8-9

Pengukuran luas penyembuhan luka
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BAB 5. KESIMPULAN DAN SARAN

5.1 Kesimpulan

Berdasarkan hasil penelitian yang diperoleh dan pembahasan sebelumnya,

kesimpulan dari penelitian ini adalah terdapat pengaruh perbedaan bahan

pembawa/vehicles HPMC, Carbopol, dan Na CMC dalam gel fraksi air ekstrak

umbi bidara upas (Merremia mammosa (Lour.)) terhadap kepadatan kolagen pada

penyembuhan luka diabetik. Vehicle Na CMC dalam gel fraksi air ekstrak umbi

bidara upas (Merremia mammosa (Lour.)) meningkatkan kepadatan kolagen

paling tinggi pada penyembuhan luka diabetik.

5.2 Saran

a. Diperlukan uji toksisitas untuk mengetahui efek samping vehicles dalam

gel fraksi air ekstrak umbi bidara upas (Merremia mammosa (Lour.)).

b. Diperlukan penelitian lebih lanjut mengenai pengaruh vehicle HPMC dan

Na CMC dalam gel fraksi air ekstrak umbi bidara upas (Merremia

mammosa (Lour.)) terhadap parameter penyembuhan luka lainnya antara

lain secara makroskopis yaitu luas luka dan secara mikroskopis yaitu

konsentrasi VEGF dan kadar hidroksiprolin.
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LAMPIRAN

Lampiran 3.8 Dokumentasi Prosedur Penelitian

a. Proses Ekstraksi

b. Proses Fraksinasi

Penambahan pelarut Pengadukan pelarut dan ekstrak umbi
bidara upas

Hasil blender potongan
umbi bidara upas

Penyampuran dengan larutan

Proses rotary
evaporator

Proses waterbath
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c. Proses pembuatan gel

Pemisahan akuades dan pelarut Hasil freeze drying

Bahan vehicles Penimbangan bahan aktif

Proses pengadukan
vehicles dan bahan aktif

Hasil akhir gel
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d. Prosedur Perawatan Luka Tikus Model Diabetes

Anestesi dengan
ketamine dan xylazine

Pencukuran rambut
tikus

Insisi full thickness
2x2 cm

Pengolesan gel

Pengambilan jaringan
setelah terminasi

Digital Repository Universitas JemberDigital Repository Universitas Jember

http://repository.unej.ac.id/
http://repository.unej.ac.id/


70

e. Pengamatan Histopatologi
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Lampiran 3.8.1 Surat Keterangan Persetujuan Etik
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Lampiran 3.8.6 Protap Ekstraksi dan Fraksinasi
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Lampiran 3.8.13 Protap Pewarnaan Preparat Menggunakan Masson’s Trichrome
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Lampiran  3.8.15 Cara Analisis Kepadatan Kolagen  Menggunakan ImageJ

a. Buka aplikasi ImageJ

b. Pilih menu File > Open > pilih gambar scale bar perbesaran 400x untuk

mengkalibrasi satuan pixel menjadi µm
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c. Pilih menu File > Open > pilih gambar

d. Pilih menu Image > Adjust > Color Threshold
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e. Atur sesuai intensitas warna biru yang memulas kolagen pada pewarnaan

Masson’s Trichrome

f. Pilih menu Analyze > Set Measurements. Tandai Area Fraction dan Limit

to Threshold
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g. Pilih menu Analyze > Analyze Particles. Tandai Summarize

h. Akan muncul tabel Summary. Presentase kepadatan kolagen ditunjukkan

oleh %Area
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Lampiran 4.1.3 Hasil Pengukuran Gula Darah Acak
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Descriptives
Kelompok Statistic Std. Error

GDA_hari_7 K- Mean 101.50 6.436
95% Confidence Interval for
Mean

Lower Bound 81.02

Upper Bound 121.98

5% Trimmed Mean 101.94

Median 105.50

Variance 165.667

Std. Deviation 12.871

Minimum 83

Maximum 112

Range 29

Interquartile Range 23

Skewness -1.531 1.014
Kurtosis 2.420 2.619

K+ Mean 90.00 9.120
95% Confidence Interval for
Mean

Lower Bound 60.98

Upper Bound 119.02

5% Trimmed Mean 89.61

Median 86.50

Variance 332.667

Std. Deviation 18.239

Minimum 72

Maximum 115

Range 43

Interquartile Range 34

Skewness 1.038 1.014
Kurtosis 1.500 2.619

P1 Mean 103.50 15.516
95% Confidence Interval for
Mean

Lower Bound 54.12

Upper Bound 152.88

5% Trimmed Mean 102.61

Median 95.50

Variance 963.000

Std. Deviation 31.032

Minimum 76

Maximum 147

Range 71

Interquartile Range 57

Skewness 1.289 1.014
Kurtosis 1.633 2.619

P2 Mean 79.00 7.767
95% Confidence Interval for
Mean

Lower Bound 54.28

Upper Bound 103.72
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5% Trimmed Mean 79.00

Median 79.00

Variance 241.333

Std. Deviation 15.535

Minimum 60

Maximum 98

Range 38

Interquartile Range 29

Skewness .000 1.014
Kurtosis 1.417 2.619

P3 Mean 95.75 3.568
95% Confidence Interval for
Mean

Lower Bound 84.40

Upper Bound 107.10

5% Trimmed Mean 95.50

Median 93.50

Variance 50.917

Std. Deviation 7.136

Minimum 90

Maximum 106

Range 16

Interquartile Range 13

Skewness 1.530 1.014
Kurtosis 2.353 2.619

GDA_hari_13 K- Mean 406.00 75.522
95% Confidence Interval for
Mean

Lower Bound 165.66

Upper Bound 646.34

5% Trimmed Mean 404.22

Median 390.00

Variance 22814.000

Std. Deviation 151.043

Minimum 244

Maximum 600

Range 356

Interquartile Range 290

Skewness .551 1.014
Kurtosis .076 2.619

K+ Mean 426.25 47.056
95% Confidence Interval for
Mean

Lower Bound 276.50

Upper Bound 576.00

5% Trimmed Mean 424.94

Median 414.50

Variance 8856.917

Std. Deviation 94.111

Minimum 331

Maximum 545
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Range 214

Interquartile Range 180

Skewness .558 1.014
Kurtosis -1.234 2.619

P1 Mean 430.50 56.796
95% Confidence Interval for
Mean

Lower Bound 249.75

Upper Bound 611.25

5% Trimmed Mean 429.50

Median 421.50

Variance 12903.000

Std. Deviation 113.591

Minimum 324

Maximum 555

Range 231

Interquartile Range 212

Skewness .184 1.014
Kurtosis -4.628 2.619

P2 Mean 430.00 74.676
95% Confidence Interval for
Mean

Lower Bound 192.35

Upper Bound 667.65

5% Trimmed Mean 429.28

Median 423.50

Variance 22306.000

Std. Deviation 149.352

Minimum 273

Maximum 600

Range 327

Interquartile Range 286

Skewness .157 1.014
Kurtosis -3.220 2.619

P3 Mean 426.50 40.500
95% Confidence Interval for
Mean

Lower Bound 297.61

Upper Bound 555.39

5% Trimmed Mean 426.22

Median 424.00

Variance 6561.000

Std. Deviation 81.000

Minimum 331

Maximum 527

Range 196

Interquartile Range 155

Skewness .176 1.014
Kurtosis .850 2.619

GDA_hari_25 K- Mean 381.50 38.010
95% Confidence Interval for
Mean

Lower Bound 260.54

Upper Bound 502.46
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5% Trimmed Mean 382.61

Median 391.50

Variance 5779.000

Std. Deviation 76.020

Minimum 284

Maximum 459

Range 175

Interquartile Range 146

Skewness -.623 1.014
Kurtosis -.649 2.619

K+ Mean 457.25 22.827
95% Confidence Interval for
Mean

Lower Bound 384.60

Upper Bound 529.90

5% Trimmed Mean 455.78

Median 444.00

Variance 2084.250

Std. Deviation 45.654

Minimum 420

Maximum 521

Range 101

Interquartile Range 83

Skewness 1.295 1.014
Kurtosis 1.140 2.619

P1 Mean 379.50 28.102
95% Confidence Interval for
Mean

Lower Bound 290.07

Upper Bound 468.93

5% Trimmed Mean 377.78

Median 364.00

Variance 3159.000

Std. Deviation 56.205

Minimum 332

Maximum 458

Range 126

Interquartile Range 103

Skewness 1.285 1.014
Kurtosis 1.257 2.619

P2 Mean 368.75 77.637
95% Confidence Interval for
Mean

Lower Bound 121.67

Upper Bound 615.83

5% Trimmed Mean 366.11

Median 345.00

Variance 24110.250

Std. Deviation 155.275

Minimum 221

Maximum 564
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Range 343

Interquartile Range 295

Skewness .604 1.014
Kurtosis -1.849 2.619

P3 Mean 465.25 50.483
95% Confidence Interval for
Mean

Lower Bound 304.59

Upper Bound 625.91

5% Trimmed Mean 464.39

Median 457.50

Variance 10194.250

Std. Deviation 100.967

Minimum 372

Maximum 574

Range 202

Interquartile Range 187

Skewness .158 1.014
Kurtosis -4.889 2.619

Tests of Normality
kelompo
k

Kolmogorov-Smirnova Shapiro-Wilk
Statistic df Sig. Statistic df Sig.

GDA_hari_1
3

K- .174 4 . .985 4 .930
K+ .207 4 . .966 4 .817
P1 .274 4 . .877 4 .324
P2 .222 4 . .948 4 .703
P3 .189 4 . .991 4 .965

a. Lilliefors Significance Correction

Test of Homogeneity of Variances
GDA_hari_13

Levene
Statistic

df1 df2 Sig.

1.117 4 15 .385

ANOVA
GDA_hari_13

Sum of
Squares

df Mean
Square

F Sig.

Between
Groups

1653.800 4 413.450 .028 .998

Within Groups 220322.750 15 14688.183
Total 221976.550 19
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Tests of Normality
kelompo
k

Kolmogorov-Smirnova Shapiro-Wilk
Statisti

c
df Sig. Statisti

c
df Sig.

GDA_hari_
25

K- .194 4 . .971 4 .848
K+ .235 4 . .885 4 .362
P1 .239 4 . .898 4 .421
P2 .238 4 . .940 4 .651
P3 .281 4 . .861 4 .264

a. Lilliefors Significance Correction

Test of Homogeneity of Variances
GDA_hari_25

Levene
Statistic

df1 df2 Sig.

3.805 4 15 .025

ANOVA
GDA_hari_25

Sum of
Squares

df Mean
Square

F Sig.

Between
Groups

34912.700 4 8728.175 .963 .456

Within Groups 135980.250 15 9065.350
Total 170892.950 19
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Lampiran 4.1.5 Hasil dan Uji Statistik Pengamatan Kepadatan Kolagen
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Descriptives
Kelompok Statistic Std.

Error
Persentase_Kolagen K- Mean 24.5982 3.31147

95% Confidence Interval
for Mean

Lower
Bound

14.0596

Upper
Bound

35.1368

5% Trimmed Mean 24.3506
Median 22.3697
Variance 43.863
Std. Deviation 6.62294
Minimum 19.36
Maximum 34.29
Range 14.92
Interquartile Range 11.40
Skewness 1.703 1.014
Kurtosis 3.182 2.619

K+ Mean 49.1035 1.29849
95% Confidence Interval
for Mean

Lower
Bound

44.9711

Upper
Bound

53.2358

5% Trimmed Mean 49.1419
Median 49.4494
Variance 6.744
Std. Deviation 2.59699
Minimum 45.65
Maximum 51.87
Range 6.22
Interquartile Range 4.89
Skewness -.749 1.014
Kurtosis 1.275 2.619

P1 Mean 52.7138 3.56547
95% Confidence Interval
for Mean

Lower
Bound

41.3669

Upper
Bound

64.0607

5% Trimmed Mean 52.6586
Median 52.2172
Variance 50.850
Std. Deviation 7.13093
Minimum 44.59
Maximum 61.83
Range 17.25
Interquartile Range 13.53
Skewness .400 1.014
Kurtosis 1.059 2.619

P2 Mean 38.5918 3.14342
95% Confidence Interval
for Mean

Lower
Bound

28.5880

Upper 48.5955
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Bound
5% Trimmed Mean 38.5947
Median 38.6183
Variance 39.524
Std. Deviation 6.28683
Minimum 31.62
Maximum 45.51
Range 13.90
Interquartile Range 12.08
Skewness -.016 1.014
Kurtosis -3.032 2.619

P3 Mean 54.8784 7.48156
95% Confidence Interval
for Mean

Lower
Bound

31.0687

Upper
Bound

78.6880

5% Trimmed Mean 54.8619
Median 54.7302
Variance 223.895
Std. Deviation 14.96312
Minimum 36.75
Maximum 73.31
Range 36.56
Interquartile Range 28.05
Skewness .059 1.014
Kurtosis 1.361 2.619

Tests of Normality
Kelompok Kolmogorov-Smirnova Shapiro-Wilk

Statistic df Sig. Statistic df Sig.
Persentase_Kolag
en

K- .357 4 . .822 4 .147
K+ .234 4 . .968 4 .827
P1 .212 4 . .983 4 .922
P2 .203 4 . .957 4 .763
P3 .220 4 . .972 4 .852

a. Lilliefors Significance Correction

Test of Homogeneity of Variances
Persentase_Kolagen

Levene
Statistic

df1 df2 Sig.

1.215 4 15 .345

ANOVA
Persentase_Kolagen

Sum of
Squares

df Mean Square F Sig.

Between Groups 2503.962 4 625.991 8.578 .001
Within Groups 1094.631 15 72.975
Total 3598.594 19
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Multiple Comparisons
Dependent Variable:   Persentase_Kolagen

(I)
Kelompo
k

(J)
Kelompo
k

Mean
Differe
nce (I-J)

Std.
Error

Sig. 95% Confidence
Interval

Lower
Bound

Upper
Bound

LSD K- K+ -
24.5052

5*

6.040
51

.001 -
37.380

3

-
11.630

2
P1 -

28.1155
8*

6.040
51

.000 -
40.990

6

-
15.240

5
P2 -

13.9935
4*

6.040
51

.035 -
26.868

6

-
1.1185

P3 -
30.2801

7*

6.040
51

.000 -
43.155

2

-
17.405

1
K+ K- 24.5052

5*
6.040

51
.001 11.630

2
37.380

3
P1 -

3.61033
6.040

51
.559 -

16.485
4

9.2647

P2 10.5117
1

6.040
51

.102 -
2.3633

23.386
7

P3 -
5.77492

6.040
51

.354 -
18.650

0

7.1001

P1 K- 28.1155
8*

6.040
51

.000 15.240
5

40.990
6

K+ 3.61033 6.040
51

.559 -
9.2647

16.485
4

P2 14.1220
4*

6.040
51

.034 1.2470 26.997
1

P3 -
2.16459

6.040
51

.725 -
15.039

6

10.710
4

P2 K- 13.9935
4*

6.040
51

.035 1.1185 26.868
6

K+ -
10.5117

1

6.040
51

.102 -
23.386

7

2.3633

P1 -
14.1220

4*

6.040
51

.034 -
26.997

1

-
1.2470

P3 -
16.2866

3*

6.040
51

.017 -
29.161

7

-
3.4116
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P3 K- 30.2801
7*

6.040
51

.000 17.405
1

43.155
2

K+ 5.77492 6.040
51

.354 -
7.1001

18.650
0

P1 2.16459 6.040
51

.725 -
10.710

4

15.039
6

P2 16.2866
3*

6.040
51

.017 3.4116 29.161
7

*. The mean difference is significant at the 0.05 level.
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